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1 Lighting scenes
About Light and shadow in the real world

In the real world, when light shines on a surface, the parts of the surface 
facing toward the light source appear illuminated, and the parts of the 
surface facing away from the light source appear dark. If one object is 
located between a second object and the light source, the first object casts a 
shadow onto the second object.

Related topics

� ”Absorption, reflection, and refraction of light” on page 9

� ”Sources of direct light” on page 14

� ”Indirect (global) vs. direct illumination” on page 13

Absorption, reflection, and refraction of light

The color of the objects we see in the natural world is a result of the way 
objects interact with light. When a light wave strikes an object, it can be 
absorbed, reflected, or refracted by the object. All objects have a degree of 
reflection and absorption.

Example of caustics. Image by Dan Pressman
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1 | Lighting scenes
About > Absorption, reflection, and refraction of light
Note In the natural world, light can also be transmitted by an 
object. That is, light can pass through an object with no 
effect (an x-ray, for example). These types of light, however, 
are not represented in Maya because they have no visual 
effect. 

Absorption. 

Light stops at the object and does not reflect 
or refract. Objects appear dark or opaque. 

Example: wood.

Reflection on a smooth surface.

Light bounces off the surface of a material at 
an angle equal to the angle of the incoming 
light wave.

Example: mirrors or glass.

See also ”Diffuse, Specular, and Glossy 
reflection” on page 11.

Reflection on a rough surface (also called 
Scatter).

Light waves bounce off at many of angles 
because the surface is uneven. 

Example: the earth (that’s why the sky is 
blue).

See also ”Diffuse, Specular, and Glossy 
reflection” on page 11.
Lighting
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1 | Lighting scenes

About > Absorption, reflection, and refraction of light
Diffuse, Specular, and Glossy reflection 

Reflection is divided into three types: diffuse, specular, and glossy. 

Refraction

Light goes through the object and bends at 
an angle. 

Example: diamond (greater angle) or water 
(lesser angle)

See also ”Diffuse, Specular, and Glossy 
refraction of light” on page 12.

Diffuse reflection.

Diffuse surfaces reflect (scatter) light in 
many angles. 

Diffuse reflection accounts for more of the 
color than any other type of distribution 
because most objects are opaque and reflect 
light diffusely. 

Glossy reflection.

Glossy surfaces are actually specular 
surfaces with micro surfaces at angles to 
surface plane. 

These micro surfaces reflect light not only 
specularly but also diffusely (at angles very 
close to the specular transmission), giving 
the surface a glossy appearance.
Lighting
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About > Absorption, reflection, and refraction of light
Diffuse, Specular, and Glossy refraction of light

Specular reflection.

Specular surfaces reflect light at the same as 
the angle at which the light strikes the 
surface. 

Specular reflection gives objects a glossy or 
mirror-like appearance. 

Diffuse refraction.

Diffuse refraction scatters light in many 
angles. 

Glossy refraction.

Glossy surfaces are actually specular 
surfaces with micro surfaces at angles to 
surface plane. 

These micro surfaces refract light not only 
specularly but also diffusely (at angles very 
close to the specular transmission), giving 
the surface a glossy appearance.
Lighting
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About > Indirect (global) vs. direct illumination
Related topics

� ”Indirect (global) vs. direct illumination” on page 13

� ”Create a Maya light source” on page 40

Indirect (global) vs. direct illumination

Indirect (Global illumination)

Indirect light is all the inter-reflected light in a scene. Global illumination 
is an approximation of real-world indirect light transmission. 

With global illumination, the contribution of bounced light from other 
surfaces in the scene is used to calculate the overall light contribution and 
the color values at points on objects that are not directly illuminated (that 
is, at points that do not receive light directly from a light source, such as a 
spot light).

Global illumination occurs when light is reflected off of or transmitted 
through an opaque (reflection only), transparent or semi-transparent 
surface (see Diffuse, Specular, and Glossy refraction of light) from a 
surface to bounce off or be absorbed by another surface. 

Specular refraction.

Specular surfaces reflect light at the same as 
the angle at which the light strikes the 
surface. 

Global 
illumination 
is indirect 
illumination, 
bounced or 
transmitted 
by nearby 
objects. Local 

illumination 
is direct 
illumination 
from a light 
source.
Lighting
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Examples: 

• A crack at the bottom of a door can cause light to spill into a room. 

• White walls reflect light from the light source to another surface in a 
room.

• A body of water can transmit light from its surface to the floor. (This 
is an example of Caustics, a form of global illumination.)

Local illumination (Light sources)

Local illumination is only the light provided directly from a light source 
(such as a spot light). 

Direct light is emitted from a light source and travels in a straight path to 
the illuminated point (either on a surface or in a volume). 

Examples:

• A spot light illuminates an actor on stage

• Sunlight shines directly on sunbathers

With direct illumination only each light source's contribution is used to 
calculate the overall light contribution to any given illuminated point. For 
more information about mental ray for Maya direct lighting, see ”Direct 
light sources” on page 14.

Related topics

� ”Absorption, reflection, and refraction of light” on page 9

� ”Global illumination” on page 21

� ”Caustics” on page 22

� ”Color bleed” on page 23

� ”Final gather” on page 29

� ”High Dynamic Range Imaging (HDRI)” on page 31

� ”Participating media” on page 24

� ”Global illumination and caustics workflow” on page 61

Direct light sources

Sources of direct light

Maya has a number of light sources that let you achieve a wide variety of 
lighting effects. 
Lighting
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About > Sources of direct light
Without no light sources to your scene, your scene would render black 
because there is no light to illuminate objects (see ”Default lighting in 
Maya” on page 17). By controlling its intensity, color and direction, light 
becomes a key factor in creating a scene in Maya. 

With Maya, you have much more control over the placement, intensity, 
and characteristics of lights than you do with real-world lights. Shadows, 
specular highlights, diffuse, and glow all contribute to how light affects a 
scene.
Lighting
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About > Sources of direct light
Related topics

� ”A typical direct light/shadow workflow” on page 39

� ”Create a Maya light source” on page 40

Area Light source

Directional Light

Ambient Light 

Spot Light source
(can be turned into a mental ray for Maya area light)

Images by Alan Opler

Point Light source
(can be turned into a mental ray for Maya area light)

Volume Light source
Lighting
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About > mental ray Area Light
mental ray Area Light

Though you can render Maya’s area light source with mental ray for 
Maya, it can be used only as a direct light source. If you want to render an 
area light source with mental ray for Maya to achieve indirect illumination 
(for example, to create the most realistic soft shadows), you must use a 
mental ray for Maya area light. 

You create a mental ray for Maya area light by turning a Maya point light 
or spot light into one. See ”Create a mental ray area light source” on 
page 42. 

The mental ray for Maya area light works by casting rays from sample 
points on the light to create smooth shadows. 

Default lighting in Maya

By default, Maya scenes do not contain light sources. 

However, Maya’s default lighting helps you to visualize objects in Shaded 
display in the Scene view (press 5). If you turn default lighting off and 
have no lights in the scene, the scene appears black. 

To turn lights on or off, if for example, you want to see or render 
incandescent objects (for which no lighting is required), see ”Turn default 
lighting on or off” on page 43.

Default light source at render time

If you render a scene without a light, Maya creates directional light during 
the render so that your objects can be seen. Without it, your objects would 
not be illuminated; that is, your render would be black. 

This default light is parented to the rendered camera. The entire scene is 
illuminated no matter where the camera is facing. The surface areas 
directly facing the camera are bright while the surface areas hidden from 
the camera are dark. This provides surface contours that look realistic. 

After the render completes, Maya removes the default light from the 
scene.

Note You cannot use a Maya area light to create a mental ray for 
Maya area light. 
Lighting
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Light decay

In the real world, a light’s brightness is strongest at the light source and 
decreases or decays further away from the light source. In Maya, a light’s 
brightness decays only if decay is turned on (see ”Decay Rate” on 
page 104). The light’s color, however, remains the same no matter how far 
it is from the light source. 

In Maya, you can select a preset brightness decay rate by setting the Decay 
Rate attribute. The preset brightness decay rates are usually good enough 
to create most types of lighting effects. In some cases, however, you may 
want to create a unique type of brightness decay. 

Related topics 

� ”Move the Decay regions of a spot light” on page 46

� ”Interactively set decay regions” on page 51. 

Note The IPR default light source that is added to the scene 
during rendering operates much the same way as the Maya 
default light source at render time.

• The IPR default light source is removed from the scene 
as soon as the IPR session is terminated (for example, 
when you click the IPR stop button).

• The IPR default light source is not saved with the scene, 
preventing you from accidentally adding the IPR default 
light to their saved scene.

Image courtesy of The Art of Maya
Lighting
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Custom intensity and color decay rates

You can also create decay effects not seen in the real world. For example, 
you can use a custom Intensity curve to make a spot light’s brightness 
increase further away from the light source, or you can use a custom Color 
curve to make the color of a spot light change with distance. 

Intensity curves and color curves are graphical representations of a light’s 
brightness and color with distance. You can use the Graph editor to view 
them . The vertical axis represents the intensity or color intensity value, 
and the horizontal axis represents distance from the light source. 
(Intensity curves and color curves are similar to animation curves, except 
the horizontal axis of an animation curve represents time.)

Related topics 

� ”Create custom spot light intensity or color decay” on page 53.

Light linking

When you create a light source, the new light source illuminates all 
surfaces in the scene by default (assuming you set the light source’s 
properties appropriately). Similarly, when you create a surface, all lights 
in the scene illuminate the new surface.

You can link lights with surfaces so that only a specific light (or group of 
lights) illuminates a specific surface (or group of surfaces), or, conversely, 
only a specific object (or group of objects) receive illumination from a 
specific light (or group of lights). 

Note You can use this technique only for a Spot Light.

Images 

courtesy of

The Art of Maya
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Light linking can help you render scenes more efficiently and quickly. You 
can create light sets to control the relationship between lights and objects 
in complex scenes. 

Related topics

� ”Determine a light’s area of illumination” on page 47. 

� ”Link light sources to surfaces” on page 47

� ”Link sets of lights and objects” on page 47

� ”Select objects illuminated by a specific light” on page 49

� ”Select lights illuminating a specific object” on page 50

Glows, halos, and lens flares

Any light visible to the camera lens has the potential to produce an optical 
effect. You can use the Optical FX utility to create glows, halos, or lens 
flares on any light source that shines directly into the camera. See ”Glow 
nodes” on page 131 for details.

How glow works in animation

Especially in animations, light sources may become blocked (occluded) by 
moving objects. In the real world, the gradual movement of the objects 
cause the optical effect of a light glow to diminish gradually. However, in 
computer graphics, the light glow may suddenly disappear, which seems 
unnatural to human eyes.

In Maya, when you add a glow to a light, a geometry object is 
automatically created to compute the percentage of visibility of the light to 
help minimize the unnatural disappearance of computer-generated glow. 

• For spot lights, a disc or circle (directedDisc) is created.

• For point lights, a sphere (renderSphere) is created.

• For area lights, a rectangle (renderRect) is created.

To change the size of the glow object, see ”Adjust the size of the glow 
object” on page 59.

Note You can also control how the glow from one surface affects 
the intensity of another’s surface glow (see ”Create 
environments that glow” on page 60) or create illuminated 
fog for a particular light (see ”Create illuminated fog” on 
page 61).
Lighting
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About > Global illumination
Related topics

� ”Glow nodes” on page 131 for details.

Global illumination and caustics

Global illumination

Global illumination is the technique used to capture indirect illumination, 
the natural phenomenon where light bounces off anything in its path until 
it is completely absorbed.

Global illumination lets you achieve realistic, real-world lighting 
conditions, which is particularly good for: 

• Architectural visualizations and industrial design projects that require 
physically accurate lighting.

• Entertainment projects that require credible, but not necessarily 
physically accurate, lighting. 

mental ray for Maya creates Global illumination by tracing the paths of 
photons and recording their bounce points in a photon map.

Caustics, focused light effects, are a form of global illumination. 

Related topics

� ”Indirect (global) vs. direct illumination” on page 13

Note You can render Global Illumination only with the mental 
ray for Maya renderer. 

(Images by Dan) Pressman

Indirect illumination
Lighting
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� ”Caustics” on page 22

� ”Color bleed” on page 23

� ”Participating media” on page 24

� ”Photon tracing” on page 25

� ”Render with global illumination” on page 65

Caustics

Caustics are light effects that caused by specularly (as opposed to 
diffusely) reflected or refracted light. 

• Refracted caustics happen when specularly transmitted light bends 
through a transparent or semi-transparent object or volume onto a 
diffuse surface.

Note You can render Caustics only with the mental ray for Maya 
renderer. 

Refracted caustics

(Image by Lisa Williamson)

Reflected caustics

(Image by Dan Pressman)
Lighting
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• Reflected caustics happen when specularly reflected light bends 
through a transparent or semi-transparent object or volume onto a 
diffuse surface. 

Related topics

� ”Diffuse, Specular, and Glossy reflection” on page 11

� ”Diffuse, Specular, and Glossy refraction of light” on page 12

� ”Render with Caustics” on page 67

Color bleed

Color bleeding is a global illumination effect where reflected light projects 
some of the object’s diffusely (as opposed to specularly or glossily) 
reflected color onto a nearby surface.

An object’s diffuse color is partially reflected while the rest of the colors 
are absorbed. The light that is reflected can project some of the diffuse 
color onto the object next to it. 

For example, a bright red apple on a pure white table cloth ‘spills’ red 
onto the table cloth. 

Related topics

� ”Absorption, reflection, and refraction of light” on page 9

� ”Tweak color bleed” on page 66

Note In the natural world, caustics are actually a form of global 
illumination, but they are treated separately by mental ray 
for Maya, making it easier for you to control them. 
Lighting
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Participating media

Participating media is a form of indirect illumination where light interacts 
with particles that occupy a space, rather than with a surface. In Maya, 
photons interact with volumetric effects that participate in the transport of 
light by absorbing some of the light. 

Example of participating media are shafts of light in a dusty barn or the 
glow around beam of light from a car headlight. 

Participating media works similarly to the way global illumination works 
on surfaces, except that volume shaders and volume photon shaders are 
required. 

Participating media can disperse volumetric caustics too.

Note You can render participating media only with the mental 
ray for Maya renderer. 

(Image by Dan Pressman)Color bleeding
Lighting

24



1 | Lighting scenes

About > Photon maps
Photon tracing

Photon maps

Photon maps are: 

• Required to produce global illumination and caustic effects. (They are 
not required for Final Gather.)

• A 3D representation of the accumulated light energy at certain photon 
bounce points. 

• Conceptually similar to shadow maps, but they capture light instead. 

• Created during the Photon tracing stage.

• Used by the material shaders for those surfaces that participate in 
global illumination at render time to calculate the contribution of 
Global illumination and caustics. (This is added to any contribution 
provided by local (direct) illumination in the scene.) 

GI photon maps vs. caustic photon maps

Photons that are specularly reflected or refracted are stored in the caustic 
photon map; all other photons are stored in the global illumination map.

As the Shinyness parameter of the photon shader attached to an object 
increases, specular highlights become smaller and the likelihood of 
specular reflection increases. In this case, more photons migrate from the 
global illumination map into the caustic photon map, decreasing the 

Tip To see the distribution of photons for global illumination, 
you can generate a 3-dimensional visualization map in 
shaded or wireframe scene views. For more information, see 
”See the distribution of photons” on page 68.
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density of the global illumination map. (Similar considerations apply to 
the Translucence parameter, but in the opposite direction: when 
Translucence is increased, photons migrate from the caustic photon map 
into the global illumination photon map.)

• If there are not enough photons stored in the global illumination 
photon map, mental ray for Maya warns (in the status bar) that no 
photons are stored. 

• If a scene is dominated by specular reflection but caustics are turned 
off, a significant amount of illumination won’t show in the rendered 
image. 

In these cases, you need to: 

• Turn on caustics 

• Make sure the light(s) emit caustic photons 

Related topics

� ”Photon tracing” on page 26.

Photon tracing

Photon tracing creates a photon map (see ”Photon maps” on page 25), 
which is used by mental ray for Maya to render global illumination and 
caustics.

Photons work as follows:

• Light sources can emit photons (packets of energy).See ”Turn on 
photon emission for a light source” on page 63.

• Photons bounce around in the scene until the Max Photon Depth is 
met. 

• Photos can be reflected off of surfaces. 

• Photons can be refracted (transmitted) through surfaces.

• Each time a photon hits a surface, the value of the incoming energy is 
stored in the photon map (provided Conditions for photon storage are 
met).

To turn on photon tracing, see ”Turn on photon emission for a light 
source” on page 63.

Tip You can save a photon map and reuse it, either in later 
frames in a render, or in a different render at a later time. 
Lighting

26



1 | Lighting scenes

About > Photon tracing
Conditions for photon storage

Photons are stored only if the following conditions are met: 

• The surface must have a diffuse component. 

All Maya materials (Lambert, Blinn, and so on) store photons, as long 
as the Diffuse attribute is not set to 0. 

Some custom mental ray for Maya shaders do not store photons

• The photon has bounced at least once. 

The first surface hit, the illumination of which is handles by direct (not 
indirect) illumination, is not stored in the map.

• The Max Photon Depth, the setting that controls the number of times 
photons bounce around in scene, has not yet been met. 

• Directional light sources are not used. (Use either a point light for 
interior volumes [because they emit in all directions] or a spot light.)

Photons have both a direction and a position; directional lights have 
only a direction, so mental ray for Maya can’t determine the position 
of photons. As a result, too many photons are emitted but not 
recorded in the photon map, rendering resources are wasted, and 
artifacts can appear. 

• For limitations of photon tracing, see ”Troubleshoot photon tracing 
limitations” on page 91.

Advanced information about photon tracing

For general information about photon tracing, see ”Photon maps” on 
page 25.

Some photon shader parameters work a little differently than their Maya 
counterparts. Besides carrying color (or other relevant) information, some 
parameters also determine the probabilities of how photons interact with 
objects. 

These probabilities (P) are computed as follows: 

P3 = P(transmission)
= INTENSITY(transparency)
P(diffuse transmission)

= translucence
P(specular transmission)

= 1 - translucence
P2 = P(specular reflection)

= reflectivity * INTENSITY(specularColor)
P1 = P(diffuse reflection)

= diffuse * INTENSITY(color) * (1 - INTENSITY(transparency))
P0 = P(absorption)

= absorbs * (2.0 - P1 - P2 - P3)
Lighting
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The interaction with the highest P-value is most likely to be chosen. So, 
the ratios of the P-values determine what fraction of the incident photons 
are refracted (transmitted), reflected, and absorbed, respectively. The 
probabilities match the Maya materials in that derivation from Maya will 
give satisfactory results. 

Note first that photons are only stored when hitting a diffuse surface. So if 
P1 is zero for a specific instance, no photons are stored. To improve 
performance, you should disable the Globillum/Caustic Receiver. 

Translucence determines what fraction of all refracted (transmitted) 
photons are diffusely transmitted and translucenceFocus controls the 
diffusity. 

Absorption takes place only if the intensity of each color involved is less 
than one and Diffuse and Reflectivity are within the prescribed range. 

If the probability for specular reflection P2 is greater than zero, either a 
non-zero Shinyness (isotropic), or non-zero spreadX and spreadY 
(anisotropic) must be specified. 

Examples

Diffuse green reflection with red diffuse transmission 

absorbs         on
diffuse         1.5
color           0.0 1.0 0.0
transparency    1.0 0.0 0.0
translucence    1.0

1/6 diffuse transmission
1/6 diffuse reflection
2/3 absorption

Full specular refraction (caustics) 

refractions     on
refractiveIndex 1.5
transparency    0.9 0.9 1.0

1/1 specular transmission

Diffuse green reflection with specular isotropic blue reflection 

reflectivity   0.8
specularColor  0.7 0.7 1.0
whiteness      1.0 1.0 1.0
shinyness      20.0
diffuse        0.2
color          0.4 1.0 0.4

3/19 diffuse  reflection
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16/19 specular reflection

Final gather and HDRI

Final gather

Final gather is method of simulating global illumination. 

On its own, Final Gather is a fast and easy way to achieve good 
illumination results for architecture visualization and entertainment 
scenes that require credible, but not necessarily physically accurate, 
lighting. 

When used in combination with global illumination, Final Gather lets you 
create the most realistic, physically accurate lighting conditions for a 
scene.

With Final Gather, you can:

• create very (or purely) diffuse scenes where the indirect illumination 
changes slowly. 

For example, an opening garage door that allows light to spill into the 
garage, or dawn before the sun rises above the horizon. 

• produce very soft shadows efficiently.

• eliminate or even out dark corners.

Note Though you can use Final Gather with direct illumination to 
produce good results quickly and economically, use Final 
Gather with global illumination to produce the most 
physically accurate lighting for a scene. 

Example of final gather to illuminate a scene

Image by Dan Pressman
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• in conjunction with Global Illumination, effectively illuminate 
interiors (using Global Illumination alone can sometimes give 
splotchy results).

To render with Final Gather, see ”Render with final gather” on page 71.

How Final Gather works

When Final Gather is enabled, every object effectively becomes a source of 
ray-emitting light, mimicking the natural world in which objects influence 
the color of their surroundings. When one light ray strikes an object, a 
series of secondary rays are diverted at random angles around it to 
calculate the light energy contribution from the surrounding objects. The 
light energy is then evaluated during the ray tracing process to add the 
effect of the bounced light. 

Unlike Global Illumination, Final gather does not use photon maps to 
calculation of light at a given point in scene. Instead, mental ray for Maya 
samples the surrounding area above every point in the scene. The 
illumination at those points is then computed as direct illumination. (If 
Global illumination is also being used at the same time, Final Gather 
calculates the total incoming illumination in the scene [called irradiance].)

Final Gather rays are emitted in many directions from a sample point and 
stop according to the settings in the Final Gather section of the Render 
Globals Setting window. Because Final Gather rays do not bounce, 
secondary surfaces are not taken into consideration. (However, when rays 
hit geometry, material shaders may cast secondary reflection, refraction, 
or transparency rays, as long as those secondary rays are specular or 
glossy, not diffuse.)

Final gathering eliminates the low-frequency variation in the global 
illumination that often results if too few photons are used. (Performance is 
optimized because mental ray for Maya reuses and interpolates nearby 
final gathers.)

Final Gather and Global Illumination

You can combine Final Gather and Global Illumination techniques to:

• achieve realistic lighting and shadows more cost effectively

• reduce flicker in animations 

• effectively illuminate interiors (global Illumination on its own can 
sometimes render splotchy results)

You can reduce the number of Global Illum Photons, the Global Illum 
Energy levels, and the number of Final Gather Rays resulting in less 
rendering time, but more realistic lighting.
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To create global illumination, see ”Render with global illumination” on 
page 65.

Related topics

� ”Irradiance as the source of light” on page 31

� ”Render with final gather” on page 71

Irradiance as the source of light

You can render a scene with Final Gather without a single light source. In 
this case, the scene is illuminated by the scene irradiance or total incoming 
irradiance instead of surrounding surfaces. You can provide irradiance 
information by: 

• Adjusting the material’s Ambient Color attribute (found in the 
Common Material Attributes section of that material’s Attribute 
Editor). 

• Adjusting the material’s Incandescence attribute (found in the 
Common Material Attributes section of that material’s Attribute 
Editor). 

• Mapping a file texture to the material’s Irradiance attribute (found in 
the mental ray section of that material’s Attribute Editor). For 
example, you could import an image or series of images (to use as file 
textures) that mimic the emerging light at early dawn, before the sun 
(direct light source) has risen. 

The Irradiance Color attribute lets you control the effect of color 
bleeding. 

Related topics

� ”Final gather” on page 29

High Dynamic Range Imaging (HDRI)

Image courtesy of Amy Quek
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You can use Final Gather to produce image-based lighting (or reflection) 
with a High Dynamic Range Image (HDRI). Image-based lighting takes 
the light (and light color) represented in an image you provide to 
illuminate the scene. An HDRI image has an extra floating point value 
associated with each pixel that is used to define the persistence of light at 
that point.

A high-dynamic range image is like several images with different 
exposures combined to show the full range of light (highlight and 
shadow). In fact, some HDR images are created by compositing several 
standard images of varying (bracketed) exposure in a special HDR 
application. This is required to simulate the wide range of available light 
in a single image -- an HDR image.

Using HDR images with Final Gather lets you provide extremely realistic 
lighting.

To use HDRI images as sources of light and reflection, see ”Image-based 
lighting (sky-like illumination)” on page 33.

Related topics

� ”Render infinitely distant (sky-like) illumination and reflection” on 
page 74

� ”Render finitely distant illumination and reflection” on page 75

Tip To understand the concept of High Dynamic Range (HDR) 
images, first think of a cathedral in which bright light spills 
in through an open door and illuminates part of the interior, 
except for some of the darker corners. If you were to enter 
the structure, your eyes would adjust to compensate for the 
excess or lack of light so that you can see properly. 

HDR images have a greater capacity to describe light 
accurately (by way of floating point numbers) because they 
store the amount of light (rather than just color) represented 
in a pixel. This prevents 'blown out' or extremely dark areas 
in an image that your eyes compensate for in the natural 
world. 
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Image-based lighting (sky-like illumination)

You can simulate light emitted from an infinitely distant (environment) 
sphere to create image-based lighting more easily and efficiently. 

Image Based Lighting is a technique to create photo-realistic images. With 
image-based lighting, you use an environment texture (an image file) to 
illuminate the scene. Typically, the image is a photograph of a real 
environment, either a panoramic image or a photograph produced by 
taking pictures of a chrome ball (to capture the surrounding 
environment). 

(The alternative method, where you surround your scene with a real, 
finite geometrical sphere, is supported. If a finite distance to the 
environment is required (for example, for a closed room), you can do this. 
However, because the shape is actual geometry, mental ray processes it as 
such. If tessellated, it becomes part of acceleration structures (BSP tree) 
where it (due to its encompassing nature) can slow rendering down 
significantly and interactive Maya workflow can be hindered. With the 
workflow below, no geometry is created (or exported on .mi export); 
instead, IBL is represented by a set of shaders. You create the desired IBL 
node, then set its attributes to achieve the look you want.)

See ”Render infinitely distant (sky-like) illumination and reflection” on 
page 74.

Image-based lighting

(Uffizi Light Probe image courtesy of Paul Debevec, 
www.debevec.org/Probes.)
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Shadow

Shadow in Maya

Shadows work with lights to add realism to your scenes. Shadows help to 
define the location of objects, whether they rest on the ground or hover in 
space, for example. Shadows can be soft-edged or hard-edged, and their 
presence (or absence) can be used to add balance and contrast to objects in 
your scene. 

To create a shadow, a scene must contain a shadow-casting light, a 
shadow-casting surface, and a shadow-catching surface. The light must 
illuminate both the shadow-casting surface and the shadow-catching 
surface.

Default shadowing (none)

By default, lights in Maya do not cast shadows. You need to specify 
which, if any, lights cast shadows in your scene, depending on your visual 
goals. Too many shadows can clutter your scene, and since they take time 
to render, you may want to use as few shadows as necessary. 

If no lights in your scene cast shadows, all surfaces facing a light source 
are illuminated, even if obstructed by another surface. (When light shines 
on a surface in Maya, the parts of the surface facing toward the light 
source appear illuminated, and the parts of the surface facing away from 
the light source appear dark.)

You can, however, add shadows by controlling which combinations of 
lights and surfaces can produce shadows. Typically, you only want a few 
specific lights and surfaces to produce shadows. By limiting shadows only 
to these specific lights and surfaces, you can help reduce rendering times.

Note In Maya, surfaces that are not illuminated are not 
considered to be shadows. For example, all surfaces facing 
away from a light source are not illuminated.
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About > Depth map and raytraced shadows
Related topics

�  ”Depth map and raytraced shadows” on page 35

� ”mental ray shadow maps” on page 38

�  ”Cast shadows” on page 76

�  ”Control which objects cast shadows” on page 76

Depth map and raytraced shadows

In Maya, an individual light source can produce no shadows (default), 
depth map shadows or raytraced shadows. You can combine depth map 
shadow casting lights and raytraced shadow casting lights in a scene.

Adjusting the attributes of depth map shadows or raytraced shadows can 
simulate shadows from many different types of real-world light sources 
and objects.

Depth map shadows and ray traced shadows produce similar results, 
though depth map shadows usually take less time to render. Generally, 
choose depth map shadows unless they cannot accomplish your visual 
goal.
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About > Depth map and raytraced shadows
Depth map shadows

Depth map shadows produce very good results in almost all situations, 
with marginal increase to rendering time.

No shadows

 (default)

Depth map 

Raytraced (with reflection)

Images by Alan Opler 

Image of flowers 

by Alan Opler
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About > Depth map and raytraced shadows
A depth map represents the distance from a specific light to the surfaces 
the light illuminates. A depth map is an data file that contains the depth 
data rendered from a light’s point of view. Each pixel in the depth map 
represents the distance from the light to the nearest shadow casting 
surface in a specific direction. 

To create depth map shadows, see ”Render depth map shadows” on 
page 77.

If a scene contains a depth map shadow casting light source, Maya creates 
a depth map file (stored as a Maya IFF File) for that light source during 
rendering and uses the depth map file to determine which surfaces are in 
shadow. In some cases, you can reduce rendering times by saving and 
reusing a depth map. To find out how to reuse depth maps, see ”Reuse 
depth maps” on page 78.

Raytraced shadows

Raytraced shadows can produce soft and transparent shadows but can be 
very time consuming.

Raytracing is a type of shadow rendering where the path of individual 
light rays are calculated from their source (the light) to their destination 
(the camera).

Use raytraced shadows only to produce more physically accurate 
shadows (like those in the real world). Common purposes include: 

• (for area lights only) where shadows blur and become lighter as they 
increase in distance from the object

• to produce shadows from transparent colored surfaces

• to produce soft-edged shadows (though depth maps can also produce 
good results)

To create raytraced shadows, see ”Render raytraced shadows” on page 80.

Image of flowers 

by Alan Opler
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How do I? > Shadow catching
Related topics

� ”Shadow in Maya” on page 34

�  ”Render depth map shadows” on page 77

� ”Render raytraced shadows” on page 80

Shadow catching

You can render out shadows separately from everything else. This is 
important in many cases, for example, if you want to blur shadows. In a 
composition you can soften, blur, brighten or change the color of shadows 
to match whatever it is they are composited against. 

To catch shadows, see ”Catch shadows for an alpha channel” on page 80.

mental ray shadow maps

You can turn on Shadow Maps so mental ray generates shadow maps. To 
turn on shadow maps for mental ray, see ”Render depth map shadows” 
on page 77. 

Related topics

� ”Shadow in Maya” on page 34

How do I? Apply and adjust basic direct lighting

Plan light sources

Consider the following when planning the lights in your scene.

The purpose of light sources

Character or object illumination typically includes the following lights:

Note You can see depth map shadows in Interactive 
Photorealistic Rendering (IPR) but you cannot see raytraced 
shadows. You must render the scene in order to visualize 
raytraced shadows. See “Visualize interactively with IPR” in 
the Rendering guide for information about visualization. 
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How do I? > A typical direct light/shadow workflow
• A key light is the main light that illuminates the character or object. For 
outdoor scenes in the real world, the key light is generally the sun.

• A secondary light, often called a fill light because it fills in dark areas. 

• Backlights, if necessary, to distinguish the character or object from the 
background. 

The characteristics of light sources

Consider the following characteristics of a light source when planning 
your scenes.

Softness or hardness

Hard light produces sharp shadow lines. Hard light sources typically 
include light bulbs, bright sun, and flash lights.

Soft light is diffused and produces soft edges. Soft light sources typically 
include light shining through fabric (like drapes), reflected light, or 
sunlight diffused through clouds. 

Color

Color and temperature are closely related. A red spot light shining on a 
blue object may make it look black. Some common objects, like street 
lamps may be tinted yellow. 

Temperature

Soft orange light feels warmer than blue-green light.

Intensity

The intensity of a light source is how bright it is. For example, bright high-
noon sunlight usually is more intense than a small electronic LED. The 
intensity with which a light illuminates a subject appears to lessen (or 
decay) as the subject moves farther away from the light.

Movement

Lighthouse lights rotate. Flashlights might swing from a rope. 

A typical direct light/shadow workflow

Generally, a typical workflow to set up direct light sources is as follows:

1 Plan first to determine the look and feel of your scene and how it’s 
reflected in the light sources chosen. 

See ”Plan light sources” on page 38. 

2 Create light sources. 
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How do I? > Create a Maya light source
You can create various types of light sources for your scene and set 
attributes (options) that further define their characteristics. You can 
adjust the qualities of the lights you’ve added by changing the settings 
in the Attribute Editor and the Channel Box.

To add a light source to a scene, see ”Create a Maya light source” on 
page 40.

To adjust the attributes of a light source, see ”Adjust a light source’s 
attributes” on page 41.

3 Move light sources in the scene and otherwise control them with 
precision (optional).

To move a light source from one place to another, see ”Move a light 
source to another location” on page 42. 

To control lights with precision, see ”Position features of a light 
interactively” on page 43. 

4 Cast shadows.

By default, lights do not cast shadows in Maya. You can specify which 
lights cast shadows and choose which method Maya uses to generate 
them: raytracing or depth maps.

To cast shadows, see ”Cast shadows” on page 76. 

5 Create optional light effects such as glows, halos, or lens flares.

To create light effects, see ”Create glows, halos, or lens flares” on 
page 57.

Create a Maya light source

When you create a light, it is automatically added to the center of a scene. 
A light’s default options determine how the light affects the scene and 
whether or not it casts shadows, but you can (and typically do) change 
most of these options on a per-light basis by adjusting the light’s attributes 
(see ”Adjust a light source’s attributes” on page 41). 

You can make a one-time change to the default options of a type of light 
before you add the light, or you can adjust the options to change the way 
all subsequent lights you create look and work. 

Note As you light your scene and objects (and otherwise build 
your scene), you visualize (preview render) the scene to 
check the look and feel and accuracy of the way the light 
renders. To preview render a scene, see “Visualize 
interactively with IPR” the Rendering guide. 
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How do I? > Adjust a light source’s attributes
To create a light

• Do one of the following:

• From the Create > Lights menu, select the type of light you want 
to create. The light is automatically added to your scene.

• In the Hypershade, click the title of the Create Bar, select Create 
Maya nodes, then select the type of light you want to create. 

• Click the light icon on the Render shelf.

To set light options before you create the light

• From the Create > Lights menu, click the � next to the name of the 
light for which you want to set options.

For a description of the light options, see the following for the light 
you want to create:

• ”Create > Lights > Directional lights > �” on page 92.

• ”Create > Lights > Ambient Light > �” on page 94.

• ”Create > Lights > Area lights > �” on page 95.

• ”Create > Lights > Point Light > �” on page 96.

• ”Create > Lights > Spot Light > �” on page 97.

• ”Create > Lights > Volume Light > �” on page 98.

Related topics

� ”Sources of direct light” on page 14

� ”mental ray Area Light” on page 17

Adjust a light source’s attributes

You can adjust basic attributes of a light, such as type, color, and intensity. 

To change attributes of a light in your scene

• Do one of the following: 

Note Avoid instancing lights. This is particularly important for 
shadow depth maps and light fog. 

Copy the lights instead of instancing. For light fog, make 
sure that light fog is duplicated independently of the light 
because when you duplicate a light, its light fog is not 
duplicated with it.
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How do I? > Create a mental ray area light source
• Select the light icon in a view and select 
Window > Attribute Editor.

• Double-click the light icon in Hypershade light tab or work area.

For a description of the light source’s attributes, see ”Light nodes” on 
page 102.

Related topics

� ”Sources of direct light” on page 14

� ”Create a Maya light source” on page 40

� ”Position features of a light interactively” on page 43

Create a mental ray area light source

Create a mental ray for Maya area light by turning a Maya point light or 
spot light into one. 

To create a mental ray area light

1 Add, then select a Maya point or spot light in the scene.

2 Open the Attribute Editor (Ctrl+a).

The Attribute Editor displays the selected light’s attributes.

3 Click the lightShape tab, expand the mental ray section, then expand 
the Area Light subsection.

4 Turn on Area Light.

5 Adjust the Area Light settings as desired, making sure to turn on the 
Visible flag if you want to make the area light visible in the final 
rendering. (Typically, light sources only illuminate a scene and are not 
visible to the camera. If you want a light to be visible (a table lamp or 
light bulb, for example), you need to make it explicitly visible. This 
does not affect the light contribution of the light.)

 See ”mental ray attributes (point, spot, directional)” on page 113.

Related topics

� ”mental ray Area Light” on page 17

Move a light source to another location

Each type of light is represented by a different icon in the scene views. 
Like any other object in your scene, you can select a light and move, scale, 
or rotate it interactively with a manipulator or with numerical precision 
by changing the values in the Channel Box. To work with a camera this 
way, see “Use manipulators” the Basics guide.
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How do I? > Turn default lighting on or off
To direct the light emitted from a light source and otherwise position 
features of lights (such as a camera’s pivot point), see ”Position features of 
a light interactively” on page 43.

Turn default lighting on or off

For more information about default lighting, see ”Default lighting in 
Maya” on page 17. 

To turn default lighting off or on, turn on the Enable Default Light check 
box in the Render Options section of the Render Global Settings window. 
Enable Default Light is on by default.

Position features of a light interactively

Show, hide, or resize a light manipulator

You can interactively adjust the attributes of certain light sources in a view 
using light manipulators. Light manipulators display in scene views (or, 
in some cases, the light source’s view, if you look through the light 
source). You can:

• ”Move the center of interest or origin” on page 44

• ”Move the pivot point” on page 45

• ”Move the Cone Radius of a spot light” on page 45

• ”Move the Penumbra Radius of a spot light” on page 45

• ”Move the Decay regions of a spot light” on page 46

• ”Move barn doors (shutters) of a spot light” on page 46

To show a light manipulator

1 Select a light’s icon.

2 Click the Show Manipulator Tool button from the toolbox to see the 
light’s manipulator (or press the hotkey t).

3 Click the Index manipulator to display each of the different types of 
light manipulators. The position of the dash on the Index Manipulator 
indicates which manipulators display. 

Directional

Point

VolumeSpot

Area
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How do I? > Move the center of interest or origin
To display a specific light manipulator

1 Select a light.

2 Click Display > Camera/Light Manipulator, then select a manipulator.

To hide light manipulators

• Select Display > Hide > Light Manipulators.

To change the size of a light manipulator

• Press - (decrease) or = (increase).

Related topics

� ”Create a Maya light source” on page 40

Move the center of interest or origin

Move the two parts of this manipulator to change the location (origin) and 
direction (Center Of Interest) of a light. All lights include this option.

To show the manipulator, see ”Show, hide, or resize a light manipulator” 
on page 43.

Related topics

� ”Create a Maya light source” on page 40

None Pivot Cone Penumbra Decay Origin/Center Of
Radius Radius RegionInterest/

Origin
Radius
Decay/

Center of 
Origin

Interest
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How do I? > Move the pivot point
Move the pivot point

Move the Pivot manipulator and then click it to change the point that a 
light pivots about when you move the light or the center of interest. Click 
the Pivot manipulator again to disable the pivot point. All lights include 
this option.

To show the manipulator, see ”Show, hide, or resize a light manipulator” 
on page 43.

Related topics

� ”Create a Maya light source” on page 40

Move the Cone Radius of a spot light

Move the Cone Radius manipulator to change the angle of a spot light’s 
beam. Only the spot light includes this option.

To show the manipulator, see ”Show, hide, or resize a light manipulator” 
on page 43.

Related topics

� ”Create a Maya light source” on page 40

Move the Penumbra Radius of a spot light

Move the Penumbra Radius manipulator to change how the brightness of a 
spot light beam decreases only near the edge of the beam. Only the spot light 
includes this option.

Pivot

Cone Radius
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How do I? > Move the Decay regions of a spot light
To show the manipulator, see ”Show, hide, or resize a light manipulator” 
on page 43.

Related topics

� ”Create a Maya light source” on page 40

Move the Decay regions of a spot light

Move the Decay Regions manipulators to separate a spot light’s beam into 
regions that are illuminated and regions that are not. Only the spot light 
includes this option.

See also ”Interactively set decay regions” on page 51.

To show the manipulator, see ”Show, hide, or resize a light manipulator” 
on page 43.

Related topics

� ”Create a Maya light source” on page 40

Move barn doors (shutters) of a spot light

Move the Barn Doors manipulators to make a spot light’s beam square, or 
to flatten one side of the beam. You can also change the spot light’s Barn 
Door values in the Attribute Editor. Only the spot light includes this option.

To use barn doors, see ”Apply barn doors (shutters) to a beam of light” on 
page 55.

To show the manipulator, see ”Show, hide, or resize a light manipulator” 
on page 43.

Penumbra Radius
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How do I? > Determine a light’s area of illumination
Related topics

� ”Create a Maya light source” on page 40

Light specific surfaces

Determine a light’s area of illumination

Just as you can look through characters’ eyes to view and animate a scene 
through their view, or look through a camera, you can look through a 
light to see its exact area of illumination. 

To look through a light

1 Select the light.

2 Click Panels > Look through selected. 

Link light sources to surfaces

To link selected lights to surfaces

1 Select the lights and surfaces you want to link.

2 In the Rendering menu set, select Lighting/Shading >  Make Light 
Links.

To break links between lights and surfaces

1 Select the lights and surfaces you want to unlink.

2 In the Rendering menu set, select Lighting/Shading >  Break Light 
Links.

Related topics

� ”Light linking” on page 19

Link sets of lights and objects

For information on light links, see ”Light linking” on page 19.

Selecting a Light Linking option opens the Relationship Editor in either 
Light-Centric or Object-Centric mode. For more information on sets and 
the Relationship Editor, see the Basics guide. 
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How do I? > Link sets of lights and objects
To create a light set

1 In the Relationship Editor, select Light Centric Light Linking.

2 In the left panel (Light Sources), select the lights you want to include 
in a new set and select Edit > Create Light Set from Highlighted 
Lights. 

Maya adds a new light set to the bottom of the light list.

To create an object set

1 In the Relationship Editor, select Object Centric Light Linking.

2 In the left panel (Illuminated Objects), select the objects you want to 
include in a new set and select Edit > Create Object Set from 
Highlighted Objects. 

Maya adds a new object set to the bottom of the object list.

To add or remove an object or light from a set

1 In the Relationship Editor, select Set Editing from the drop-down 
menu.

2 In the left panel (Sets), select the set. 

Note Linking single objects to single lights is the preferred 
method of light linking (see ”Lighting/shading > Make 
Light Links” on page 99 for details). 

Object-Centric

Light-Centric
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How do I? > Select objects illuminated by a specific light
The objects (or lights) in the set are highlighted in the right panel.

3 In the right panel (Objects), select the objects (or lights) you want to 
add to the set and clear the selection of objects (or lights) you want to 
remove from the set. 

Link lights and surfaces from the command line

From the Maya command line, type:

lightlink -light <lightName> -object <surfaceName>

For example, to link spotLight1 and nurbsSphere1, type:

lightlink -light spotLight1 -object nurbsSphere1

For more information on the lightlink command, see the MEL online 
documentation.

Related topics

� ”Light linking” on page 19

Select objects illuminated by a specific light

For information on light links, see ”Light linking” on page 19.

To select all surfaces illuminated by a specific light

• Select a light, then from the Rendering menu set, select Lighting/
Shading >  Select Objects Illuminated by Light. 

All objects illuminated by the selected light are highlighted.

Related topics

� ”Light linking” on page 19

Warning!

In Maya prompt or batch mode, the regular clean up 
process that amalgamates the data from several lightlinker 
nodes into one does not take place. This may result in 
several lightlinker nodes when scenes are imported or 
referenced. To prevent this behavior, import or reference 
scene data during an interactive session. If prompt or batch 
mode must be used, ensure that you invoke the lightlink 
-q command to first force the loading of the module that 
contains the amalgamation routine. 
Lighting

49



1 | Lighting scenes
How do I? > Select lights illuminating a specific object
Select lights illuminating a specific object

For information on light links, see ”Light linking” on page 19.

To select all lights illuminating a specific surface

• Select the surface, then from the Rendering menu set, select Lighting/
Shading >  Select Lights Illuminating Object. 

All lights illuminating the specified surface are highlighted.

Related topics

� ”Light linking” on page 19

Control area lights

Control highlights of an area light 

To control the specular highlight size and orientation for an 
area light

Position and scale the area light using Maya transformation tools (such as 
standard or light-specific manipulators) through the Channel Box, 
Attribute Editor, and so on. IPR the scene to adjust the specular highlight 
interactively. For more information on the manipulators, see “Use 
manipulators” in the Basics guide.

Control soft lighting distribution

To control soft lighting distribution for an area light

The size and orientation of the area light icon controls the light 
distribution. A large area light emits more light. The light can be non-
proportionally scaled to modulate the distribution. The farther away the 
object is from the light, the less light is cast onto the object. To adjust the 
size and orientation of the light area, see ”Show, hide, or resize a light 
manipulator” on page 43.

Related topics

� ”Create a Maya light source” on page 40
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How do I? > Produce raytraced shadows
Produce raytraced shadows

To produce realistic raytraced shadows for area lights

Only available through raytracing. Make sure to turn Raytracing on in the 
Render Global Settings window for Maya software rendering, then turn 
on Use Ray Trace Shadows in the area light's Attribute Editor. The size 
and orientation of the light controls the shadow color distribution. 

Depth map shadows also work, but you create shadows varying from 
hard to soft. Adjust the filter size to control the uniform softness of the 
shadow.

Related topics

� ”Raytraced shadows” on page 37

� ”Create a Maya light source” on page 40

Adjust decay

Interactively set decay regions

You can use the decay region manipulators to set decay regions 
interactively on a spot light. (Alternatively, you can enter exact distance 
positioning in the Attribute Editor. See ”Decay Regions attributes” on 
page 121.)

The decay regions indicate the regions you want to light and the regions 
you don’t want to light in the shape of three truncated cones. Use the 
decay region manipulators to precisely indicate these regions.

To interactively set decay regions

1 Make sure the Use Decay Regions attribute is turned on. 

Note You may have to increase the number of sample rays to 
ensure high quality shadows. This can be time- and 
processor-intensive. 

Tip When interacting with the spot light to get precision 
lighting for distance dimension, adjust the scene view so 
that it is perpendicular to the spot light icon, making it 
easier to see the distance effect head-on.
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How do I? > Interactively set decay regions
To turn on the decay region manipulators, see ”Position features of a 
light interactively” on page 43.

2 Click the Index Manipulator until you can see the decay regions on 
the spot light’s icon. (To learn more about the Index Manipulator, see 
”Show, hide, or resize a light manipulator” on page 43.)

3 Drag the decay region rings to set start and end distances. If you want, 
you can verify and fine-tune these values in the Attribute Editor.

Tip When Interactively setting a light’s decay regions:

• Leave the Attribute Editor open and IPR render the 
scene so you can make changes interactively to get the 
look you want.

• Apply a Light Fog (click the box next to Light Fog in the 
Light Effects section of a spot light’s Attribute Editor) to 
see the results.
Lighting

52



1 | Lighting scenes

How do I? > Create custom spot light intensity or color decay
Related topics

� ”Light decay” on page 18

� ”Create a Maya light source” on page 40

Create custom spot light intensity or color 
decay

Create custom spot light decay

An intensity curve or an expression can be used to control decay. You can 
also create a custom brightness decay rate using an intensity curve. You 
can edit curves in the Expression or Graph editors. For more information 
about the Expression and Graph editors, search the Maya Help. 

To create a custom brightness decay

1 In the Light Effects section of the spot light’s Attribute Editor, click the 
Create button beside the Intensity Curve attribute.

Maya creates an Intensity Curve node and connects it to the Intensity 
attribute.

2 Turn on Light Direction Only in the Attribute Editor that appears.
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How do I? > Create custom spot light intensity or color decay
Create custom spot light color decay

You can create a custom color decay rate using a set of color curves (a red 
curve, a green curve, and a blue curve).

To create a custom color decay

1 In the Light Effects section of the spot light’s Attribute Editor, click the 
Create button beside the Color Curves attribute.

2 Turn on Light Direction Only in the Attribute Editor that appears.

Maya creates a Red Curve node, a Green Curve node, and a Blue 
Curve node and connects them to the Color attribute.

Edit custom intensity and color decay

You can edit intensity curves or a set of color curves either in the Attribute 
Editor or in the Graph Editor. Intensity or color curves display as a table 
of values in the Attribute Editor. 

To view the table for an Intensity Curve in the Attribute 
Editor

• Click the box next to the Create button. 

To view the attribute table for Color Curves and the Intensity 
curve (after you create them)

• Select the spot light in the view. 

To work with Intensity or Color curves in the Graph Editor

• To adjust the Intensity or Color Curves interactively, select the spot 
light and open the Graph Editor (Windows > Animation Editors > 
Graph Editor). An intensity curve appears as a dark blue line, and 
color curves display as red, green, and blue lines.

• To edit points or entire curves, use the Graph editor. For more 
information on the Graph editor, see the Animation guide. 

Related topics

� ”Light decay” on page 18

� ”Create a Maya light source” on page 40

Tip When creating intensity and color curves for a light source, 
IPR Render the scene or part of the scene to get instant 
feedback on the changes you make to the light’s intensity 
and color curves.
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How do I? > Control a spot light’s circle boundary
Adjust a spot light’s light circle

Control a spot light’s circle boundary

Select the spot light, and choose Panels > Look Through Selected in the 
view. This represents the view from the spot light.

The green circle represents the cone boundary. Any objects outside this 
circle are not lit by this spot light. Camera tracking, tumbling, or dollying 
work well in this view to help shine the spot light exactly on the desired 
area. 

Apply barn doors (shutters) to a beam of light 

Apply barn doors when you want to create the effect of light pouring out 
of a half-opened door. Barn doors are shutters applied to a spot light’s 
beam. Barn Doors are off by default; you must turn them on, then adjust 
them to get the desired light spill.

To use Barn Doors

1 Select a Spot Light whose manipulators are displayed, then turn Barn 
Doors on in the Attribute Editor. 

2 In the Light Effects section of the spot light’s Attribute Editor, turn on 
Barn Doors. 
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How do I? > Apply barn doors (shutters) to a beam of light
3 Select Look Through Selected from the view’s Panels menu to look 
through the selected light. (The Barn Doors manipulators are only 
visible in the light’s view.)

Four blue lines appear. These lines represent a rectangular boundary 
for the spot light. No light reaches the regions outside the blue line-
boundaries. 

4 You can directly manipulate each of the four lines with the Move tool 
to shift the boundaries. (Alternatively, you can enter precise numerical 
values in the Attribute Editor.) 

Attributes are in degrees measured from the spot light to the blue 
line-boundary. For instance, for an 80 degree spot light, the four blue 
line-boundaries are 40 if the boundaries lie exactly at the spot light 
border. 

When you use the Barn Doors settings, the lightShape sample changes 
at the top of the Attribute Editor.

5 Tweaking the penumbra value displays a second circle. Change the 
value in the Attribute Editor or click the Index Manipulator icon to 
display and use the manipulator, then select Panels > Look Through 
Selected to see the circle.

The region between the two circles results in a softer illumination. 
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How do I? > Create a light optical effect
6 If the penumbra value is set to 0 (the default) and Barn Doors is on, 
this results in a very hard-edged look to the lighting. With a non-zero 
penumbra value, the barn door effect is a smooth illumination of the 
scene.

You can also verify the illumination by looking at the Light Shape and 
Intensity Sample at the top of a spot light’s Attribute Editor. These 
change as you change the values for the spot light.

7 To return to the current view, select the view from the Panel menu.

Related topics

� ”Create a Maya light source” on page 40

Create glows, halos, or lens flares

Create a light optical effect

You can add an optical effect to any light. 

Default settings.

Penumbra Angle at -5.

Barn Doors at 10, 10, 40, 40
Penumbra Angle at 0.

Barn Doors at 10, 10, 40, 40
Penumbra Angle at 10.
Lighting

57



1 | Lighting scenes
How do I? > Create a light optical effect
Related topics

�  ”Glows, halos, and lens flares” on page 20

To create a light optical effect

1 Create a light for which you want to apply and position optical effects.

2 In the light’s Attribute Editor, map the Optical FX utility to one of the 
light’s attributes (for example, click the box beside Color then select 
Optical FX from the Glow Utilities tab in the Create Render Node 
window).

3 IPR render the scene to see the optical effect.

Re-position an optical light effect

You can move the glow or halo you have attached to a light or include 
more than one optical effect in the scene. 

To re-position an Optical FX utility node

1 Create a Locator and place it anywhere in the scene (Create > Locator). 

Tip The results of an optical effect (such as flame) applied to a 
light are not visible in the Scene View. 

To see the results, IPR render the effect, then drag a 
marquee around the rendered object to watch how the 
effect changes as you adjust it.

Point light with
mapped Glow
in view.

IPR rendered result.
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2 Shift-select the locator in the view, then select the light. 

You can now move the locator anywhere in the scene and the optical 
light effect moves with it.

Adjust the size of the glow object

For more information about the optical effect of a light glow, see ”How 
glow works in animation” on page 20.

To change the size of a glow object

For a Point light, renderSphere has a radius attribute which can increase 
the size of the glow object.

Each light's Radius attribute can be changed to increase/decrease the 
radius as well.

Related topics

� ”Glows, halos, and lens flares” on page 20

� ”Create a Maya light source” on page 40

After.Before.

Change the attributes

of the light effect while IPR 
rendering to test various 
effects
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Create environments that glow

When you first open Hypershade, three nodes are available by default in 
the Materials tab: lambert1, particleCloud1, and shaderGlow1. 

Use the Shader Glow node for environment glows. 

Shader glow from one surface can affect the intensity of another surface’s 
glow. For example, a large glowing surface that enters a scene may appear 
to cancel the affect of, or alter, the glow of a smaller surface in the scene. 
This phenomenon is caused by the Shader Glow’s Automatic Exposure 
setting.

To get the right glow and halo intensities using Shader Glow

1 Turn on Auto Exposure in the Shader Glow’s Attribute Editor (open 
the Shader Glow Attribute Editor by double-clicking the Shader Glow 
swatch located in the Post Process folder in Visor’s Rendering section). 

2 Select a frame in which the halo and glow effects have the look you 
want.

3 Render the scene in Render View.

The glow intensity normalization factor and halo intensity normalization 
factor are printed in the Maya command shell or DOS window. They 
look similar to this sample:

glow intensity normalization factor = 0.0110171.

halo intensity normalization factor = 0.0243521.

These are the values Maya uses if Auto Exposure is turned off. 

4 In the Shader Glow’s Attribute Editor, set the Glow Intensity and Halo 
Intensity to the values for the glow intensity normalization factor and 
halo intensity normalization factor.

5 Turn off Automatic Exposure.

6 Render the scene again at full resolution of your intended output.

Related topics

�  ”Glows, halos, and lens flares” on page 20

Note The Shader Glow node’s attributes are the same as the 
Optical FX’s attributes. See ”Optical FX Attributes” on 
page 131.
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Create illuminated fog

You create illuminated fog by adding it to an existing light. 

To add illuminated fog to a light

1 Select the light for which you want to illuminate fog.

2 In the Light Effects section of the light’s Attribute Editor, click the map 
button beside the Light Fog attribute.

Maya automatically creates a light fog node, connects it to the light 
node, and displays its Attribute Editor.

Related topics

�  ”Glows, halos, and lens flares” on page 20

� ”Create a Maya light source” on page 40

Render with global illumination and 
caustics

Global illumination and caustics workflow

Generally, the workflow is as follows:

1 Make sure that at least one light source in the scene emits photons. 

See ”Turn on photon emission for a light source” on page 63.

2 Make sure that at least one surface is casting or receiving caustics. 

By default, all objects cast and receive caustics, though typically not 
all have to in order for you to achieve the look you want. To fine-tune 
the look of global illumination or caustics or to reduce render times, 
you can specify exactly which objects should cast and, or receive 
photons. See ”Flag objects to cast and receive photons” on page 64.

Note To create fog that fills the entire scene, not just within the 
illumination of a specific light, use the Env(iroment) Fog 
Volumetric material.
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3 Make sure raytracing and the desired global illumination and, or 
caustic effects are enabled. 

See ”Render with global illumination” on page 65.

4 Render with mental ray for Maya.

Related topics

� ”Global illumination” on page 21

� ”Caustics” on page 22

Set up mental ray for Maya raytracing

Tip To see the distribution of photons for global illumination, 
you can generate a 3-dimensional visualization map in 
shaded or wireframe scene views.

 

Tip Combine global illumination with Final Gather for the most 
physically accurate lighting effects. See ”Combine global 
illumination with Final Gather” on page 73.

Note If you want to render Global illumination, Caustics, or 
mental ray for Maya raytraced shadows, raytracing must be 
turned on. 

By default, mental ray for Maya raytracing is turned on, 
which means that you can just proceed with the global 
illumination or caustics workflow.
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To turn on raytracing and set attributes

1 Select the Rendering menu set.

2 Open the Render Global Settings window. 

Click the Select Window > Rendering Editors > Render Globals or 
click the Render Global Settings window icon. 

3 Select the mental ray for Maya render. 

4 Click the mental ray tab.

5 Turn on Ray Tracing. 

Find Ray Tracing in the General section.

6 Set the raytracing attributes. 

Related topics

� ”Depth map and raytraced shadows” on page 35

Turn on photon emission for a light source

At least one direct light source (a point light or spot light) must emit 
photons for global illumination or caustics to work. 

For more information on direct light sources, see ”Sources of direct light” 
on page 14. 

To turn photon tracing 

1 Select the light source you want to emit photons.

For example, spot light. 

2 Open the Attribute Editor (Ctrl+A).

3 Select the light’s shape tab. 

4 Set Decay Rate to Quadratic.

This causes light levels in the scene to decrease in intensity based on 
the inverse square law (naturally).

5 Set the photon emission attributes. 

See ”mental ray attributes (point, spot, directional)” on page 113.

6 Repeat this procedure for every light source you want to emit 
photons.

Related topics

� ”Global illumination” on page 21

� ”Caustics” on page 22

� ”Photon maps” on page 25

� ”Photon tracing” on page 26
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Flag objects to cast and receive photons

By default, all objects cast and receive caustics, but not all have to in order 
for you to achieve the look you want. You can fine-tune the look of global 
illumination or caustics (or reduce render times) by specifying exactly 
which objects should cast and, or receive photons. 

Though you can use these per-object (local) settings alone in many cases, 
usually you use them in conjunction with scene-wide (global) overrides to 
give you the maximum amount of control over the rendering of global 
illumination and caustics. (See ”Set scene-wide photon tracing overrides” 
on page 64.)

How you combine per-object global settings depends on what you want to 
achieve. You can, for example, flag specific objects to receive global 
illumination, while the rest of your objects in your scene don’t. Or, you 
can flag all objects to receive caustics, but only one object to generate 
caustics. 

To flag objects for photon participation

1 In the Scene view, select the object for which you want to change 
global illumination settings. 

2 Open the Attribute Editor (Ctrl+A).

3 Click the selected object’s shape node.

4 Expand the mental ray section, and turn off DeriveFromMaya. 

5 Change the Global illumination flag or the Caustics flag. 

6 Set scene-wide (global) global illumination overrides if necessary. 

See ”Set scene-wide photon tracing overrides” on page 64.

7 Modify the object’s material photon attributes, if necessary. 

(Expand the selected object’s Attribute Editor (Ctrl+A), expand the 
mental ray section, then adjust the attributes. 

Related topics

� ”Photon tracing” on page 26

Set scene-wide photon tracing overrides

Global illumination overrides and Caustics overrides let you turn on or off 
the photon casting or receiving capabilities of all objects in your scene at 
once (with the exception of any flags you’ve set on a per-object basis, 
see”Flag objects to cast and receive photons” on page 64). 
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You can further define the look of your scene and reduce the rendering 
load (especially good for test renders) by defining to what degree all 
objects should or should not participate in global illumination and 
caustics. 

Global illumination overrides and Caustics overrides always work in 
conjunction with local (per-object) global illumination and caustics 
settings (see ”Flag objects to cast and receive photons” on page 64). Per-
object flags always take precedent over global overrides, giving you a 
great amount of control over the how photons are distributed. You can, 
for example, flag specific objects to receive global illumination, while the 
rest of the objects in your scene don’t. 

To set scene-wide (global) photon tracing overrides

1 Select the Rendering menu set.

2 Open the Render Global Settings window. 

Click the Select Window > Rendering Editors > Render Globals or 
click the Render Global Settings window icon. 

3 Select the mental ray for Maya render. 

4 Click the mental ray tab.

5 Expand the Overrides section. 

6 Set the Global Illum Generating settings and, or the Global Illum 
Receiving settings. 

7 Make sure the appropriate per-object global illumination flags have 
been set for the look you want to achieve. 

See ”Flag objects to cast and receive photons” on page 64.

Related topics

� ”Global illumination” on page 21

� ”Photon tracing” on page 26

� ”Set up mental ray for Maya raytracing” on page 62

� ”Flag objects to cast and receive photons” on page 64

Render with global illumination

To render global illumination

First, make sure at least one light source in your scene emits photons (see 
”Turn on photon emission for a light source” on page 63). 

1 Select the Rendering menu set.

2 Open the Render Global Settings window. 
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Click the Select Window > Rendering Editors > Render Globals or 
click the Render Global Settings window icon. 

3 Select the mental ray for Maya render. 

4 Click the mental ray tab.

5 From the Quality Presets drop-down list, select PreviewGlobalIllum. 

Raytracing and global illumination (in the Caustics and Global 
illumination section of the tab) are automatically enabled. 

6 Render with the default settings. 

If the default settings are not sufficient to achieve the look you want 
(or to reduce render speed), tweak the global illumination settings 
until you achieve the look you want. 

Related topics

� ”Global illumination” on page 21.

� ”Troubleshoot global illumination doesn’t work or looks incorrect” on 
page 89.

Tweak color bleed

Color bleeding is a by-product of rendering with global illumination. You 
can affect color bleed with or without lights in the scene.

To render color bleed with light sources in the scene

1 Make sure Illuminates by Default is turned on for the light source(s). 
(It is on by default.) 

2 Select the object onto which you want to bleed color.

3 Tweak the Diffuse attribute of your object’s shaders if necessary. 

4 (Optional) Adjust the Irradiance Color slider to reduce or increase 
intensity of the color bleed.

5 Render with mental ray for Maya.

To render color bleed with no lights in the scene

1 Turn off Illuminates by Default for the light source(s).

2 Select the object onto which you want to bleed color.

Tip If your scene contains caustics, global illumination or final 
gather, and you would like to see those effect during mental 
ray IPR, in Render View select IPR > IPR > Render Globals.
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3 In the mental ray section of that object’s Attribute Editor, do any of the 
following:

• Adjust the Ambient Color attribute.

• Add some color to the Incandescence attribute. 

4 Render with mental ray for Maya. 

Related topics

� ”Color bleed” on page 23

Render with Caustics

To render caustics

First, make sure at least one light source in your scene emits photons (see 
”Turn on photon emission for a light source” on page 63). 

1 Select the Rendering menu set.

2 Open the Render Global Settings window. 

Click the Select Window > Rendering Editors > Render Globals or 
click the Render Global Settings window icon. 

3 Select the mental ray for Maya render. 

4 Click the mental ray tab.

5 From the Quality Presets drop-down list, select PreviewCaustics. 

Raytracing and caustics (in the Caustics and Global illumination 
section of the tab) are automatically enabled. 

6 Render with the default settings. 

If the default settings are not sufficient to achieve the look you want 
(or to reduce render speed), tweak the caustics settings until you 
achieve the look you want. 

Tip To see progress messages when rendering, set Export 
verbosity to Progress messages in the Translation section of 
the Render Global Settings window. 

Note Caustic-casting objects are recommended to have a low 
diffuse shader, for example, Phong set to 0.3. The refractive 
index should be greater than 1. 

Caustics-receiving objects should have a high diffuse 
shader, for example, Lambert set to 0.8. 
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Related topics

� ”Caustics” on page 22.

� ”Troubleshoot caustics don’t work or look incorrect” on page 90.

Render a separate global illumination pass

You can render global illumination separate from direct illumination in a 
separate pass. 

During a global illumination rendering pass, direct illumination from light 
sources and ambient and incandescent material portions are disregarded. 
Corresponding to the Maya render passes, colored backgrounds, image 
planes and certain shaders acting as incandescent emitters, for example, a 
Surface Shader, are rendered.

To render a separate global illumination pass

1 Select the Rendering menu set.

2 Open the Render Global Settings window. 

Click the Select Window > Rendering Editors > Render Globals or 
click the Render Global Settings window icon. 

3 Select the mental ray for Maya render. 

4 Click the mental ray tab.

5 Expand the Render Layer / Pass Control section.

6 Turn on Enable Global Passes. 

See the distribution of photons

Tip If your scene contains caustics, global illumination or final 
gather, and you would like to see those effect during mental 
ray IPR, in Render View select IPR > IPR > Render Globals.

Shaded view of a 
scene

Photon map 
visualization

Final Gather 
visualization
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You can generate a 3-dimensional visualization of a photon map or final 
gather map. This helps you fine-tune your settings. 

Generate a map visualization to see the distribution of photons (and their 
energies) and final gather points (with stored irradiance) in the scene. This 
feedback can help you diagnose possibly unexpected global illumination 
effects or tune your scene more efficiently to get the desired look. 

Generated photon or final gather visualization maps appear in shaded 
and wireframe Scene views. Normals and directions are only visible in 
wireframe view. In shaded view, photons and final gather points are 
displayed as colored points, the color representing the irradiance estimate. 

To generate a photon or final gather visualization map

1 Select Window > Rendering Editors > mental ray > Map Visualizer. 

If a mapVizShape node does not already exist in the scene (that it, if a 
visualization has not already been generated for the scene), a 
mapVizShape node is created and the mental ray Map Visualizer 
window appears. 

2 Adjust the display attributes of the visualization map.

For descriptions of these attributes, see ”mapVizShape node” on 
page 139.

3 Do any of the following: 

• Click Refresh to reload the map after you make changes. 

• Click Close to close the window but retain the visualization map 
(and thus the mapVizShape node). 

Work with Final Gather

Retune the final gather settings for pre-Maya 
6.5 scenes

The following tips may help you retune your final gather settings to work 
with the new final gather method introduced in Maya 6.5. These tips may 
also improve performance and quality in your scenes.

• Adjust Final Gather Rays 

Note Photon or final gather visualization maps are not 
visible in final rendering.
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Because the final gather method is more efficient, you should use 
significantly fewer final gather rays. Typically, only one tenth of the 
original number of final gather rays are now required. You can adjust 
Final Gather Rays in the Render Global Settings window, mental ray 
tab, Final Gather section.

• Adjust Final Gather radii 

If the mental ray for Maya statistics on final gathering show more 
than 30 to 50 final gather points per interpolation (of the Min Radius 
and Max Radius), you should reduce the radii size to improve 
performance. 

To see statistics and adjust final gather radii

1 In the Render Global Settings window, mental ray tab, Translation 
section, select Info Messages from the Export Verbosity drop-down 
list. 

2 Render your scene. 

3 In the Maya Output window check for the final gather points statistic: 

4 Adjust the Min Radius and Max Radius in the Render Global Settings 
window, mental ray tab, Final Gather section, if necessary. 
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Render with final gather

Final gather is very flexible and many different factors can contribute to 
its effect. You’ll need to experiment with settings to achieve the look you 
want. 

To render with Final Gather

First, turn off Maya default lights (see ”Turn default lighting on or off” on 
page 43) and, if you have any light sources in the scene, turn off their 
Illuminates by Default attribute. 

1 Select the Rendering menu set.

2 Open the Render Global Settings window. 

Click the Select Window > Rendering Editors > Render Globals or 
click the Render Global Settings window icon. 

3 Select the mental ray for Maya render. 

4 Click the mental ray tab.

5 From the Quality Preset drop-down list, select PreviewFinalGather. 

Final Gather (in the Final Gather section of the tab) is automatically 
enabled. 

6 Change any of the following optional settings, which can have an 
effect: 

• The camera background color. 

• The object’s material’s colored Incandescence or Ambient color 
attributes.

• Irradiance contributions from shaders. 

• Irradiance color mapping contributions from shaders. 

• The number and location of lights in the scene. 

7 Render with the default settings. 

Tip Final Gather is view dependent and is recalculated for each 
frame in a sequence. 

If you are not adjusting the camera position, the position of 
any objects, or any Final Gather attributes, you can store 
and reuse Final Gather illumination results to speed up 
rendering. 

See ”Store and reuse Final Gather results” on page 72. 
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If the default settings are not sufficient to achieve the look you want 
(or to reduce render speed), tweak the Final Gather settings until you 
achieve the look you want.  

Related topics

� ”Final gather” on page 29

� ”Store and reuse Final Gather results” on page 72

� ”Combine global illumination with Final Gather” on page 73

Store and reuse Final Gather results

By default, mental ray for Maya ignores any previously generated final 
gather results each time final Gather render happens; final gather results 
are freshly calculated. 

You can store final gather results so that later frames can use the results 
from a frame rendered earlier to speed up the Final Gather rendering 
process. 

Store and reuse final gather results when you aren’t going to be changing 
any final gather settings between renders (for example, when rendering a 
still image). You may be able to reuse a final gather map for animation, as 
long as the irradiance values for moving objects don't change significantly.

By default the file is saved into the current project's 
mentalRay\finalgMap directory.

To store and reuse previously generated final gather results

1 Make sure Final Gather is turned on and the attributes are set. See 
”Render with final gather” on page 71. 

Tip If your scene contains caustics, global illumination or final 
gather, and you would like to see those effect during mental 
ray IPR, in Render View select IPR > IPR > Render Globals.

Note You cannot reuse Final Gather results if you change final 
gather settings. In this case, the following Output window 
messages indicate that the previous results can’t be used:

• RCFG 0.2 info: finalgMap/test1:final gather options 
differ from ones currently used, content ignored. 

• RCFG 0.2 info: overwriting final gather file "finalgMap/
test1".
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2 Set the Final Gather file attributes: 

• Final Gather File

• Final Gather Rebuild

3 Render.

Related topics

� ”Final gather” on page 29

� ”Combine global illumination with Final Gather” on page 73

Combine global illumination with Final Gather

Combine global illumination with Final Gather to achieve the most 
physically accurate illumination results, which are particularly good for 
interior architectural shots that require the effect of the light contribution 
from exterior and interior light sources.

To combine global illumination with Final Gather (guidelines)

1 Set up any exterior lights, then set up interior lights.

See ”Create a Maya light source” on page 40 for more information.

2 Turn on the Physical attribute for each light source that emits photons 
for global illumination, and set the Decay Rate to Quadratic. 

See ”Turn on photon emission for a light source” on page 63.

3 Do one of the following: 

• Set up basic global illumination (see ”Render with global 
illumination” on page 65), then turn on Final Gather and custom 
set its attributes. Make sure the Precompute Photon Lookup attribute is 
set for final gather. 

• Set up basic final gather (see ”Render with final gather” on 
page 71), then turn on Global Illumination custom set its 
attributes. Make sure the Precompute Photon Lookup attribute is set for 
final gather. 

4 Render with mental ray for Maya.

Related topics

� ”Final gather” on page 29

� ”Store and reuse Final Gather results” on page 72
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Work with High Dynamic range images 
(HDRI)

Render infinitely distant (sky-like) illumination 
and reflection

You can render illumination and reflection from an infinite distance with 
High Dynamic range images. See ”Image-based lighting (sky-like 
illumination)” on page 33 and also ”Create blurry reflections” on page 314.

How image-based lighting (IBL) works

When an IBL node is created one or more of the following mental ray for 
Maya shaders is used:

Environment Shader

Along with Final Gathering this shader implements classic style image-
based lighting. The color of the environment is picked up by final 
gather rays and incorporated into surface illumination. An 
environment shader is passive. It doesn’t actively contribute to the 
scene’s lighting; instead, it gets sampled only as needed. Best results 
are achieved if the IBL texture is diffuse. A specific case would be a 
texture consisting of a single color; this results in ambient occlusion 
computation. 

Photon Emission Shader

Photons are emitted from the IBL environment sphere. These photons 
pick up their energies (or colors) from the IBL texture. A photon 
emission shader emits all its photons once per frame. It is more active 
than an environment shader in this sense. Photons work best with 
mostly diffuse IBL textures. 

Light Shader

A low-resolution control texture is computed (from the file or 
procedural IBL texture) and mapped to the IBL environment sphere. 
Whenever direct lights are sampled, the light shader is invoked. In 
this sense, the light shader approach is the most active one, and the 
most expensive. The IBL environment can be seen as one big area 
light. This approach works best (also due to importance sampling) if 
the IBL texture contains sharp features, and preferably contains many 
more black than non-black pixels. 

These three approaches may be combined to achieve specific effects, at the 
expense of computation time. 
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To use image-based lighting

1 In the mental ray tab of the Render Globals Settings Window, click the 
Create button in the Image Based Lighting (IBL) section. 

2 A new IBL node is created, replacing any currently connected node. 
(Though multiple IBL environments can exist in a scene, only one can 
be used at a time.) 

A sphere-like tool appears in the scene view, and the IBL node’s 
Attribute Editor automatically pops up.

3 Set the IBL node’s attributes. 

For details, see ”Image based lighting node attributes” on page 114.

4 Position the IBL node with the sphere-like tool. 

For details, see ”Position an IBL texture” on page 75.

5 Render with Final Gather or Global Illumination to illuminate the 
scene.

Final gathering picks up incandescence samples from the environment 
texture. Illumination models deal with these samples similar to direct 
light arriving from, for example, a spot light. 

Position an IBL texture

When you create an IBL node, its shape is represented in the scene view. 

Moving (and to a certain extent scaling) the shape has no effect because 
the environment is considered infinitely distant. For best results, scale the 
shape as large as your clipping planes permit. 

Rotations, however, let you position the texture on the IBL node shaders. 

Render finitely distant illumination and 
reflection

To render finitely distant illumination and reflection

1 Place your scene into a large sphere. 

This sphere will be used as the light source. (It is geometry that gets 
tessellated.)

2 Assign a Lambert material to the sphere and set the following 
attributes:

• Set colour to white.

Note IBL environments can be previewed interactively (if 
they are File texture based). 
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• Set Incandescence to around 70%. (You can later increase or 
decrease this value to increase or decrease the intensity of the 
light.)

3 Map the Incandescence to the HDR image you want to use.

4 Render with Final Gather (see ”Render with final gather” on page 71), 
with the Final Gather Rays set to between 50 and 100. 

5 Make sure Global illumination is turned on.

6 Tweak the Diffuse attribute of your object's shaders, if necessary . 

Cast shadows

See shadows in the scene view

You can preview shadows quickly and easily in the scene view without 
rendering your scene.

To see shadows in the scene view

1 In the Render Stats section of the surface’s Attribute Editor, make sure 
Casts Shadows is turned on.

2 In the scene view, click Lighting > Shadows. 

Related topics

� ”Shadow in Maya” on page 34

Control which objects cast shadows

You can select which objects and, or which shadows render 
independently. For instance, you can render an object so it does not cast 
shadows, but can receive shadows cast by other objects. 

To set which objects do or don’t cast shadows, see “Render Stats” in the 
Rendering guide.

Note • Hardware shadows do not display for transparent 
objects. 

• Hardware shadows do not work with point and area 
lights.

• In hardware X-Ray mode (Shading > Shade Options > X-
Ray), all objects are transparent, and no hardware 
shadows display.
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Select a range of objects and shadows to render

If you want to render only objects and shadows within a specific distance 
range from the camera (for example, only foreground objects), you can use 
the camera’s clipping planes to control which objects and shadows render. 
(However, separating objects into layers is better from a maintenance 
standpoint.)

See “Clipping planes” in the Rendering guide for more details. 

Related topics

� ”Shadow in Maya” on page 34

Render depth map shadows

For more information about depth map shadows, see ”Depth map 
shadows” on page 36.

To create a depth map shadow

1 Select the light for which you want to produce a shadow.

2 In the Shadows section of the light’s Attribute Editor, turn on Use 
Depth Map Shadows.

3 Select the surface on which you want to cast a shadow.

4 In the Render Stats section of the surface’s Attribute Editor, turn on 
Casts Shadows.

Note If you want to isolate only the shadow information on 
objects that receive shadows, assign a Use Background 
material to them.
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To create mental ray shadow maps

For Maya Spot Lights, Directional Lights, and Point Lights, there is a 
Shadow Maps subsection in the mental ray section of the light’s Attribute 
Editor. You can turn on Shadow Maps so mental ray generates shadow 
maps. 

Related topics

� ”Shadow in Maya” on page 34.

�  ”Depth map shadows” on page 36.

Reuse depth maps

If you use depth map shadows, by default Maya calculates at least one 
depth map for each depth-map enabled light source and for each frame of 
the animation during rendering. 

In some cases, you can reduce rendering times by saving and reusing a 
light’s depth map. See the following table to determine if reusing a depth 
map is advantageous for your particular circumstance.

Maya saves depth map files in the renderDate/depth directory of the 
current project, by default.

Tips • Set the light’s Dmap Resolution to the lowest value that 
produces shadows of acceptable quality. As a starting 
point, set Dmap Resolution to the same value as the 
rendering resolution. If Dmap Resolution is too low, 
shadow edges appear jagged. If Dmap Resolution is too 
high, rendering times increase.

• When batch rendering from the command line, generate 
shadow depth maps before rendering the scene by using 
the Render -sp <sceneName> command and option. 
This can help reduce rendering times and you can reuse 
the depth maps for subsequent renders. 

Note mental ray does not handle shadow maps on scaled light 
sources very well. Proportional scaling for the light should 
be used instead.
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How do I? > Reuse depth maps
 

If you are... Do this...

Rendering a single frame several 
times, each time making 
adjustments to object or light 
properties, but not moving lights or 
objects, the depth map does not 
change and can be reused.

Set Disk Based Dmaps to Reuse 
Existing Dmap(s). Maya calculates 
the depth map the first time you 
render and save it to disk. During 
each subsequent render, Maya 
reads the depth map from disk.

Rendering an animation in which 
the light or the objects it illuminates 
do not move (for example, a camera 
fly-through), the depth map does 
not change from frame to frame 
and can be reused.

Set Disk Based Dmaps to Reuse 
Existing Dmap(s) and turn off 
Dmap Frame Ext. Maya calculates 
the depth map when it renders the 
first frame and save it to disk. 
During each subsequent frame 
render, Maya reads the depth map 
from disk.

Rendering an animation in which 
lights and, or the objects they 
illuminate do move, the depth map 
changes from frame to frame. If you 
are rendering the entire animation 
several times, each time making 
adjustments to object or light 
properties, but not changing the 
way lights or objects move, the 
depth maps for each frame is the 
same as in the initial render and can 
be reused.

Set Disk Based Dmaps to Reuse 
Existing Dmap(s) and turn on 
Dmap Frame Ext. Maya calculates 
the depth maps for each frame the 
first time you render the animation 
and save them to disk. During 
each subsequent render, Maya 
reads the depth maps from disk.

Rendering a single frame or an 
animation, have previously saved 
depth maps to disk, and have 
moved lights and, or the objects it 
illuminates, the depth maps are 
now different, and you cannot 
reuse the depth masks on disk.

Set Disk Based Dmaps to 
Overwrite Existing Dmap(s). 
Render the frame or animation 
once. Maya calculates the depth 
map(s) and save them disk, 
overwriting any depth map(s) that 
already exist on disk.

If you want to continue adjusting 
object or light properties, but not 
move lights or objects, set Disk 
Based Dmaps to Reuse Existing 
Dmap(s).
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How do I? > Render raytraced shadows
Related topics

� ”Shadow in Maya” on page 34.

�  ”Depth map shadows” on page 36.

Render raytraced shadows

To create a raytraced shadow

1 Select the light for which you want to produce a shadow.

2 In the Raytrace Shadow Attributes section of the light’s Attribute 
Editor, turn on Use Ray Trace Shadows.

3 Select the surface on which you want to cast a shadow.

4 In the Render Stats section of the surface’s Attribute Editor, turn on 
Casts Shadows.

5 In the Raytracing Quality section of the Render Global Settings 
window (Windows > Rendering Editors > Render Globals), turn on 
Raytracing.

6 Render.

Related topics

� ”Shadow in Maya” on page 34

�  ”Raytraced shadows” on page 37

Catch shadows for an alpha channel

For more information about shadows, see ”Shadow in Maya” on page 34.

The following is a simple example of how to use the Use Background 
material to catch shadows. 

To capture only shadows in an alpha channel

1 In Hypershade, create a Use Background material and assign it to the 
shadow catching object(s). 

Rendering a single frame or an 
animation, have previously saved 
depth maps to disk, but do not 
want to use the depth maps that are 
on disk.

Set Disk Based Dmaps to Off. 
Maya calculates the depth map(s) 
every time you render. Maya does 
not read depth maps from disk. 
Maya does not save depth maps to 
disk.

If you are... Do this...
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How do I? > Catch shadows for an alpha channel
2 Select the objects(s) in the scene casting shadows. In the Render Stats 
section of the objects’ Attribute Editor, turn Primary Visibility off. 

3 Render the scene. 

Shadow information is captured in the alpha channel.

To assign Use Background to stand-in geometry

Use this workflow to make a 3D object look like it’s in a real environment. 
The real environment usually comes from a snapshot or live action shot 
that is assigned to an image plane. The object can cast shadows onto the 
seemingly invisible plane, which acts as the shadow catcher.

Create an image plane using the scene in which you want to place the 
stand-in geometry:

1 Select View > Image Plane > Import Image from the current view.

2 Browse to the file you want and click Import. 

A placement icon appears in either the current view or all views, 
depending on the Display mode you set, and the Image Plane 
Attribute Editor opens.

3 Select an Image File or Texture from the Type drop-down list, then 
click the folder icon next to Image Name to load an image plane into 
the view.

4 Set the following attributes in the Image Plane Attributes section:

• Display–looking through camera

• Image Plane–attached to Camera

5 Adjust the perspective camera so that the construction grid plane 
aligns approximately where you want to place the object.

Note Make sure you select the Image Plane Attached to Camera 
option to position the plane where you want it before you 
create a stand-in object. For more information about image 
planes, see “Image plane” in the Shading guide.
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How do I? > Catch shadows for an alpha channel
6 Create and position a NURBS or polygonal plane on which to cast 
shadows and reflections.

7 Position the object you want to cast shadows onto the stand-in 
geometry on the grid plane.

8 In Hypershade, create a Use Background material and assign it to the 
plane.

9 Create and position lights in the scene. Turn on the Use Depth Map 
Shadows attribute in the Shadows section of the light’s Attribute 
Editor to see the shadows in the rendered result.

Adjust the grid plane

to position it in

the scene.
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How do I? > Remove shadows
10 Render the scene in Render View (for best results, do not IPR render).

11 Adjust the location of the geometry, the lights, and the Use 
Background attributes if necessary and then re-render the scene at any 
time. 

Remove shadows

For more information about shadows, see ”Shadow” on page 34.

Removing unnecessary shadows can help reduce rendering times. You 
can either remove all shadows produced by a specific light, or all shadows 
cast by a specific surface. To determine which objects cast shadows, see 
”Control which objects cast shadows” on page 76.

To remove all shadows produced by a specific light

1 Select the light.

2 In the Depth Map Shadow Attributes section of the light’s Attribute 
Editor (or in the Shape Keyable tab of the light’s Attribute Spread 
Sheet), turn off Use Depth Map Shadows.
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How do I? > Troubleshoot lights don’t light the object
3 In the Raytrace Shadow Attributes section of the light’s Attribute 
Editor (or in the Shape Keyable tab of the light’s Attribute Spread 
Sheet), turn off Use Ray Trace Shadows.

To remove all shadows cast by a specific surface

1 Select the surface.

2 In the Render Stats section of the surface’s Attribute Editor (or in the 
Render tab of the surface’s Attribute Spread Sheet), turn off Casts 
Shadows.

Troubleshoot direct light sources

Troubleshoot lights don’t light the object

• Check that the light's Illuminates by Default attribute is on when no 
light linking is intended.

• If light linking is desired, make sure the light is linked to the object.

• Check that the object is assigned to a shading group and that this 
shading group has a surface material.

Troubleshoot surface glows affect glow of 
another surface

Normalize the shader glow. See ”Create environments that glow” on 
page 60.

Troubleshoot Shader Glow, Light Glow, and 
Light Fog limitations

• Shader Glow and Light Glow attributes cannot be texture mapped, 
but they can be animated.

• Light Glow is not rendered in raytraced reflections and refractions.

Note You can make all shadow casting surfaces cast shadows 
from all shadow casting lights, even if they are not linked 
together, by turning off Shadows Obey Light Linking in the 
Render Options section of the Render Global Settings 
window (Windows > Render Globals).
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How do I? > Troubleshoot shadow map problems
Troubleshoot shadows

Troubleshoot shadow map problems 

Avoid instancing lights. Copy the lights instead of instancing. For light 
fog, make sure that light fog is duplicated independently of the light 
because when you duplicate a light, its light fog is not duplicated with it.

Troubleshoot inaccurate shadows from 
shadow depth maps

For extremely large-scale units, the shadowing from shadow depth maps 
may be inaccurate due to the incorrect scale of the near and far clipping 
planes of the shadow render. 

The following example shows you how to manually set the near and far 
clipping planes of the shadow depth map render (it assumes you have a 
shadow casting light called lightShape):

setAttr lightShape.useDmapAutoClipping 0;

setAttr lightShape.dmapFarClipPlane 10000;

setAttr lightShape.dmapNearClipPlane 0.01;

where the first line turns off the automatic generation of near/far clipping 
planes, and the last two lines let you set the near/far clipping plane values 
appropriately.

Troubleshoot transparent objects cast 
shadows for shadow depth maps

Unlike Studio, transparent objects cast shadows for shadow depth maps. 
If you do not want transparent objects to cast shadows, turn off the 
object’s shadow flag in its Attribute Editor.

Troubleshoot shadow quality poor with light 
fog

Shadow quality can be very poor when you use light fog.

This may be because your coneAngle is much larger than the region of 
interest, and use dmap auto focus is turned on. When use dmap auto focus is 
on, the renderer computes the smallest angle to obtain the highest 
precision on the shadow of interesting objects. But when light fog is 
turned on, the angle must be as large as the light coneAngle. 

Turn off that attribute, then adjust the dmap focus accordingly to fit the 
scene you are interested in.
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How do I? > Troubleshoot hardware shadows produce unexpected results
Troubleshoot hardware shadows produce 
unexpected results

Hardware shadows rely on an unobstructed modeling view to work 
properly. You will get unexpected results if you have hardware shadows 
enabled while the modeling panel is obscured by another window.

Do not allow other windows to cover any part of your modeling view.

Troubleshoot lights don’t cast shadows

• Check that the light's Illuminates by Default attribute is on when no 
light linking is intended.

• Make sure Cast Shadows or Receive Shadows are turned on for the 
object.

• If a shadow depth map is expected, check that Enable Depth Maps is 
turned on in Render Global Settings window (Window > Rendering 
Editors > Render Globals).

• If a raytraced shadow is expected, check that the Ray Depth Limit (for 
the light and in Render Global Settings window) are turned up to a 
sufficient limit.

Troubleshoot shadows flicker over animations

When using shadow depth maps:

• To get the best quality when Use Dmap Auto Focus is turned on, 
make sure the large floors do not cast shadows. When large floors cast 
shadows, the region for the shadow map covers a much larger area so 
the shadow map precision is lower for the areas of attention and may 
shift over an animation.

• Try turning off Use Dmap Auto Focus and determine the constant 
angle of focus for the light that works throughout the entire 
animation. 

Troubleshoot jagged edges 

(With area lights and depth map shadows)

If an object has a Ramp Shader (adjusted to resemble a toon shader) 
assigned to it and is lit by an Area light with Depth Map Shadows, the 
shader's lines may produce jagged edges. To correct this, increase the 
Dmap Filter Size (Depth Map Shadows Attributes in the Area light's 
Attribute Editor). If that’s not enough to get rid of the jagged edges, 
increase the Dmap Bias attribute as well. 
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How do I? > Troubleshoot jagged or flickering shadow edges
Troubleshoot jagged or flickering shadow 
edges

For shadow-casting spot lights, decrease the Cone Angle.

For shadow-casting directional lights, turn on Use Light Position, turn off 
Use Dmap Auto Focus, and set Dmap Width Focus so all objects that you 
want to cast shadows do indeed cast shadows for all frames of the 
animation. 

To determine the Dmap Width Focus value, select Panels > Look Through 
Selected, and zoom the view in or out until all shadow casting objects are 
visible. Note the width of the view and use this value for Dmap Width 
Focus.

For all light types, you can do one of the following:

• Turn off Use Light Position (for directional lights only), turn on Use 
Dmap Auto Focus for the light, and turn off Casts Shadows for any 
objects (especially large objects) in the scene that do not need to cast 
shadows (they can still receive shadows).

• Increase Dmap Filter Size (to the lowest value that produces acceptable 
results) for the shadow casting light (this makes shadow edges softer).

• Increase Dmap Resolution (to the lowest value that produces 
acceptable results) for the shadow casting light.

Jagged shader lines

Smooth shader lines
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How do I? > Troubleshoot grainy or flickering shadows in illuminated fog
Troubleshoot grainy or flickering shadows in 
illuminated fog

Increase Fog Shadow Samples (to the lowest value that produces 
acceptable results) for the shadow casting light.

Troubleshoot dark spots or streaks on 
illuminated surfaces (outside of shadows)

Do one of the following:

• Turn on Use Mid Dist Dmap for the shadow casting light that 
illuminates the surface.

• Increase Dmap Bias by a small amount for the shadow casting light 
that illuminates the surface.

Troubleshoot shadow appears detached from 
shadow casting surface

Decrease Dmap Bias by a small amount for the shadow casting light.

Troubleshoot grainy or flickering shadow 
edges (raytraced shadows)

Do either of the following:
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How do I? > Troubleshoot staircase of dark triangles on surface (raytraced

shadows)
• Decrease Light Radius (point lights or spot lights) or Light Angle 
(directional lights) for the shadow casting light. This also makes 
shadow edges sharper.

• Increase Shadow Rays (to the lowest value that produces acceptable 
results) for the shadow casting light.

Troubleshoot staircase of dark triangles on 
surface (raytraced shadows)

Do either of the following:

• Increase Curvature Tolerance for the surface.

• Increase U Divisions Factor and V Divisions Factor for the surface (to 
the lowest values that produce acceptable results).

Troubleshoot Dmap resolution changes don’t 
update in IPR

If you perform an IPR render and then change the Dmap Resolution or 
Use Dmap Auto Focus, these changes do not update in the IPR render. 

For more information about IPR rendering, see “Interactive Photorealistic 
Rendering (IPR)” in the Rendering guide.

Troubleshoot global illumination and 
caustics

Troubleshoot global illumination doesn’t work 
or looks incorrect

The problem is any of the following: 

• Global illumination is not turned on. If you did not use the global 
illumination presets (see ”Render with global illumination” on 
page 65), it might be turned off. 

• Raytracing is not turned on. If you did not use the global illumination 
presets (see ”Render with global illumination” on page 65), it might be 
turned off. 
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How do I? > Troubleshoot caustics don’t work or look incorrect
• If caustics is not turned on, too many photons may have migrated 
from the global illumination photon map to the caustics photon map. 
For more information, see ”GI photon maps vs. caustic photon maps” 
on page 25.

Troubleshoot caustics don’t work or look 
incorrect

Blurry or noisy caustics

Do any of the following:

• Tweak Caustic Radius until there is no visible change, then Caustic 
Accuracy until you get the desired results.

• Work with the Caustic Filter type to sharpen or smooth caustics.

Caustics don’t work with a directional light

Don’t use directional lights for photon emission. Although you can render 
caustics and global illumination with a directional light source (that is, all 
the necessary attributes exist), we recommend against it. Because a 
directional light has no origin, it will unnecessarily shoot photons into a 
scene where they aren’t needed, thereby increasing render times 
dramatically. 

If you must render a directional light with photon emission (with mental 
ray for Maya), ensure that objects are marked properly for photon tracing. 
For more information on photon tracing and problems that may occur, see 
”GI photon maps vs. caustic photon maps” on page 25.

Troubleshoot final gather and HDRI

Troubleshoot final gather renders black

There is no source of irradiance contribution in the scene. 

Troubleshoot final gather file problems

The following Output window messages indicate that the number of final 
gather rays has changed from the existing Final Gather File, and so it 
won’t be used:

• RCFG 0.2 info: finalgMap/test1:final gather options differ from ones 
currently used, content ignored. 

• RCFG 0.2 info: overwriting final gather file "finalgMap/test1".
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How do I? > Troubleshoot HDR image warning message
Troubleshoot HDR image warning message

A warning message is generated when an HDR image is loaded into 
Maya. Just ignore it while rendering with mental ray for Maya.

Troubleshoot Photon tracing

Troubleshoot photon tracing limitations 

Shadows

During photon tracing, shadow shaders are not processed. This prevents 
light sources from casting shadows on objects twice (once through the 
shadow shader and once via transmitted photons), resulting in incorrect 
illumination. 

Additionally, photons cannot mimic some Maya features such as a depth 
limit on shadow rays. 

No view-dependent information

During the photon tracing phase, some view-dependent information (filter 
sizes, which are used in the bump and almost all texture nodes) is not 
available. You should turn off view-dependent filtering in all these nodes 
by setting Filter to zero and Filter Offset to a small positive value.

Troubleshoot photons are not bright enough

Increase Energy in light’s AE.

Troubleshoot no photons stored after emitting 
10000 photons 

This error message means that the photons emitted by the light source 
don’t hit any energy-storing object. The problem is one of the following:

• objects in the path of photons don't have photon shaders in the 
materials or don’t have photon shaders that always absorb photons.

• the receiving object has a strange shape as seen from the light source 
and mental ray for Maya is casting rays in places where they cannot 
be stored.

• the photon emitting light source is emitting photons in the wrong 
direction. 
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Reference > Create > Lights > Directional Light
Reference Menus

Create

Create > Lights > Directional Light

Adds a directional light to your scene. 

Use a directional light to simulate a very distant point light source (for 
example, the sun as viewed from the surface of the Earth).

A directional light shines evenly in one direction only. Its light rays are 
parallel to each other, as if emitted perpendicular from an infinitely large 
plane. 

Related topics

� ”Move the pivot point” on page 45

� ”Light specific surfaces” on page 47

� ”Directional Light Attributes” on page 102

Create > Lights > Directional lights > �

Intensity

See ”Intensity” on page 102.

Color

See ”Color” on page 102.

Note If you render a directional light with photon emission with 
mental ray for Maya, ensure that objects are marked 
properly for photon tracing. 

Image of flowers 

by Alan Opler
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Reference > Create > Lights > Ambient Light
Cast Shadows

If on, the light produces either depth map shadows (for directional, 
point, or spot lights) or raytraced shadows (for ambient lights). Cast 
Shadows is off by default. See also “Shadow attributes”.

Shadow color

See ”Shadow Color” on page 122.

Create > Lights > Ambient Light

Adds an ambient light to your scene. 

An ambient light shines in two ways—some of the light shines evenly in 
all directions from the location of the light (similar to a point light), and some 
of the light shines evenly in all directions from all directions (as if emitted 
from the inner surface of an infinitely large sphere). 

Use an ambient light to simulate a combination of direct light (for 
example, the sun or a lamp) and indirect light (sunlight diffused by the 
atmosphere, or lamp light reflected off the walls of a room). 

Related topics

� ”Move the center of interest or origin” on page 44.

� ”Move the pivot point” on page 45.

� ”Light specific surfaces” on page 47.

� ”Ambient Light Attributes” on page 103.

Tip • Depth map shadows are typically used for quick render 
tests when the quality is not important.

• Raytraced shadows produce more accurate results and 
can handle transparency, but can be slower.

Image of flowers 
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Reference > Create > Lights > Area Light
Create > Lights > Ambient Light > �

Intensity

See ”Intensity” on page 102.

Color

See ”Color” on page 102.

Ambient shade

See ”Ambient Shade” on page 104.

Cast Shadows

See ”Cast Shadows” on page 93.

Shadow color

See ”Shadow Color” on page 122.

Shadow rays

”Shadow Rays” on page 130.

Create > Lights > Area Light

Adds an area light to your scene. 

In Maya, area lights are two-dimensional rectangular light sources. Use 
area lights to simulate the rectangular reflections of windows on surfaces. 
An area light is initially two units long and one unit wide. Use Maya’s 
transformation tools to resize and place area lights in the scene.

Compared to other light sources, area lights can take longer to render, but 
they can produce higher quality light and shadows. Area lights are 
particularly good for high-quality still images, but less advantageous for 
longer animations where rendering speed is crucial. 

Area lights are physically based—there is no need for a decay option. The 
angles formed with the area light and the point that is shaded determine 
the illumination. As the point moves further away from the area light, the 
angle decreases and illumination decreases, much like decay.
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Reference > Create > Lights > Point Light
Related topics

� ”Control area lights” on page 50.

� ”Area Light Attributes” on page 104.

Create > Lights > Area lights > �

Intensity

See ”Intensity” on page 102.

Color

See ”Color” on page 102.

Decay rate 

See ”Decay Rate” on page 106.

Cast Shadows

See ”Cast Shadows” on page 93.

Shadow color

See ”Shadow Color” on page 122.

Create > Lights > Point Light

Adds a point light to your scene. 

You can turn a Maya point light into a mental ray for Maya area light by 
setting the light source’s mental ray attributes. See ”Create a mental ray 
area light source” on page 42.

A point light shines evenly in all directions from an infinitely small point 
in space. Use a point light to simulate an incandescent light bulb or a star.

Related topics

� ”Move the center of interest or origin” on page 44

� ”Move the pivot point” on page 45

Image of flowers 
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Reference > Create > Lights > Spot Light
� ”Light specific surfaces” on page 47

� ”Point Light Attributes” on page 106

Create > Lights > Point Light > �

Intensity

See ”Intensity” on page 102.

Color

See ”Color” on page 102.

Decay rate 

See ”Decay Rate” on page 106.

Cast Shadows

See ”Cast Shadows” on page 93.

Shadow color

See ”Shadow Color” on page 122.

Create > Lights > Spot Light

Adds an spot light to your scene. 

A spot light shines a beam of light evenly within a narrow range of 
directions that are defined by a cone. The rotation of the spot light 
determines where the beam is aimed. The width of the cone determines 
how narrow or broad the beam of light is. You can adjust the softness of 
the light to create or eliminate the harsh circle of projected light. You can 
also project image maps from spot lights.

 Use a spot light to create a beam of light that gradually becomes wider (for 
example, a flashlight or car headlight).

Image of flowers 
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Reference > Create > Lights > Volume Light
Related topics

� ”Move the Cone Radius of a spot light” on page 45.

� ”Move the Penumbra Radius of a spot light” on page 45.

� ”Move the Decay regions of a spot light” on page 46.

� ”Light specific surfaces” on page 47.

� ”Move barn doors (shutters) of a spot light” on page 46.

� ”Adjust decay” on page 51.

� ”Adjust a spot light’s light circle” on page 55.

�  ”Spot Light Attributes” on page 106.

Create > Lights > Spot Light > �

Intensity

See ”Intensity” on page 102.

Color

See ”Color” on page 102.

Cone angle

See ”Cone Angle” on page 107.

Penumbra angle

See ”Penumbra Angle” on page 107.

Drop off

See ”Dropoff” on page 107.

Decay rate 

See ”Decay Rate” on page 106.

Cast Shadows

See ”Cast Shadows” on page 93.

Shadow color

See ”Shadow Color” on page 122.

Create > Lights > Volume Light

Adds a volume light to your scene. 
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Reference > Create > Lights > Volume Light
A major advantage of using a volume light is that you have a visual 
representation of the extent of the light (the space within which it is 
bound).

The falloff of light in the volume can be represented by the color ramp 
(gradient) attribute in Maya, which prevents the need for various decay 
parameters, and also provides additional control. The color gradient is 
also useful for volume fog.

You can achieve different effects with light direction. Outward behaves 
like a point light and Downward acts like a directional light. Inward 
reverses the light direction for shading, giving the appearance of inward 
illumination. When using shadows with Inward light direction you may 
get unexpected results. In all cases the light shape dictates the extent of 
the light.

Related topics

� ”Move the center of interest or origin” on page 44.

� ”Move the pivot point” on page 45.

� ”Light specific surfaces” on page 47.

� ”Volume Light Attributes” on page 107.

Create > Lights > Volume Light > �

Intensity

See ”Intensity” on page 102.

Tip You can use a volume light as a negative light (to remove or 
decrease illumination) or to lighten up shadows. 
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Reference > Lighting/shading > Make Light Links
Color

See ”Color” on page 102.

Cone angle

See ”Cone Angle” on page 107.

Penumbra angle

See ”Penumbra Angle” on page 107.

Drop off

See ”Dropoff” on page 107.

Decay rate 

See ”Decay Rate” on page 106.

Cast Shadows

See ”Cast Shadows” on page 93.

Shadow color

See ”Shadow Color” on page 122.

Rendering menu set

Lighting/shading

Lighting/shading > Make Light Links

Link lights and objects so that specific surfaces are illuminated. 

For more information on light links, see ”Light linking” on page 19.

Lighting/shading > Break Light Links

Break links between lights and objects.

For more information on light links, see ”Light linking” on page 19.

Lighting/shading > Select Objects Illuminated 
by Light 

Select all objects lit by a selected light.

For more information on light links, see ”Light linking” on page 19.
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Reference > Lighting/shading > Select Lights Illuminated by Object
Lighting/shading > Select Lights Illuminated 
by Object

Select all lights illuminating selected objects.

For more information on light links, see ”Light linking” on page 19.

Lighting/shading > Light Linking 

For more information on light links, see ”Light linking” on page 19.

Object centric

Open the Relationship Editor in Object centric Light Linking mode. 

Light centric

Open the Relationship Editor in Light centric Light Linking mode. 

Panel menus

Lighting

Lighting > Use Default Lighting

Use in the Scene view only; it does not affect your final render. Surfaces 
appear fully illuminated in the view by Maya’s default lights. 

For more information on default lighting, see ”Default lighting in Maya” 
on page 17.

Lighting > Use All Lights

Surfaces appear illuminated by at least 8 lights (depending on the 
capabilities of you graphics card) in the scene. This option gives you a 
representation of what the lights will look like when the image is rendered.

Once you create lights, you can interactively place them and view the 
scene with lighting before you render.

Lighting > Use Selected Lights

Surfaces appear illuminated by selected lights in the view as well as in the 
Render View.

Uses only selected lights. If you change the light selection, the lighting 
also changes.
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Reference > Lighting > Use No Lights
Lighting > Use No Lights 

Hardware lighting is disabled so no shading occurs.

Lighting > Use Previously Specified Lights

Surfaces appear illuminated by the lights you previously selected.

Select this option to use the lights selected with the Specify Selected Lights 
option. This option is not available until you choose Specify Selected 
Lights. If you select a different set of lights when this option is selected, 
the scene still uses the previously selected lights.

Lighting > Two Sided Lighting

When on, illuminates both sides of an object. Two Sided Lighting is on by 
default. Note that Maya’s performance may decrease on some systems.

Lighting > Shadows

Use Lighting > Shadows to see hardware shadow maps in the Scene View. 

Hardware shadow maps from directional or spot lights for geometry 
(NURBS, polygons, subdivision surfaces) and particles (points, 
multipoints, and spheres only) can be calculated and displayed on 
graphics cards with drivers that support the ARB_multitexture and 
EXT_texture_env_combine OpenGL extensions. 

Lighting > Specify Selected Lights

Lets you use a preset selection of lights. Select the lights you want to use 
then select Specify Selected Lights. Once specified, turn on Lighting > Use 
Previously Specified Lights to use this light selection. Unlike Use Selected 
Lights, if you change the light selection, the scene still uses the previously 
selected lights.

Tip This is useful when you have already baked the lighting 
into a scene and you don't want any additional hardware 
lighting to be added to the scene in the modeling scene 
views. 

Note This menu item can be turned off by selecting any of the 
menu items above it.
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Reference > Directional Light Attributes
Nodes

Light nodes

Directional Light Attributes

All light types share the Directional Light attributes and options.

For a description of Maya’s Directional Light, see ”Create > Lights > 
Directional Light” on page 92.

Type

Click the arrow to choose a light type from the drop-down list. When 
you change a light’s type, only those attributes common to both types 
retain their previous values or settings. Values and settings for non-
common attributes are lost. When you change a light’s light type, the 
light’s position is also preserved.

For more information on Maya’s light types, see ”Sources of direct 
light” on page 14.

Color

Determines the light’s color. Click the swatch either to change the 
light’s color in the Color Chooser or to map a texture to the light. If 
you map a texture, the light projects it (depending on the light Type). 
The default setting is white. The following shows the rendered result 
when you map a Ramp texture to an Ambient light’s Color attribute.

Intensity

Represents the brightness of the light. A light with an Intensity value 
of 0 produces no light. A light with a negative Intensity value removes 
light from a scene in the area of the light’s influence. The slider range 
is 0 to 10, but you can type in a larger value for a brighter light (for 
example, 20). The default value is 1.
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Reference > Ambient Light Attributes
Illuminates by Default

If on, the light illuminates all objects and is included in the 
defaultLightSet. If off, the light only illuminates objects to which it is 
linked. Illuminates by Default is on by default.

Emit Diffuse and Emit Specular

Emit Diffuse and Emit Specular are on by default. Turning them off 
turns off the diffuse or specular shading results for the light. 

To enable or disable the diffuse and specular shading for multiple 
lights at the same time, use the Rendering Flags window 
(Window > Rendering Editors > Rendering Flags).

Ambient Light Attributes

For a description of Maya’s Ambient Light, see ”Create > Lights > 
Ambient Light” on page 93.

Type

See ”Type” on page 102.

Color

See ”Color” on page 102.

Tip Use a negative Intensity value to reduce or remove hot-
spots or glare.

Note The results do not show in the scene view. To see the 
results, test render in Render View.

Emit Diffuse ON

Emit Specular ON

Emit Diffuse OFF

Emit Specular ON

Emit Diffuse ON

Emit Specular OFF

Default setting
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Reference > Area Light Attributes
Intensity

See ”Intensity” on page 102.

Illuminates by Default

See ”Illuminates by Default” on page 103.

Ambient Shade

The proportion of directional light to omnidirectional (ambient) light. 
The slider range is 0 (light comes from all directions) to 1 (light comes 
only from the position of the light). The default value is 0.45.

Area Light Attributes

For a description of Maya’s Area Light, see ”Create > Lights > Area Light” 
on page 94.

Type

See ”Type” on page 102.

Color

See ”Color” on page 102.

Intensity

See ”Intensity” on page 102.

Illuminates by Default

See ”Illuminates by Default” on page 103.

Emit Diffuse and Emit Specular

See ”Emit Diffuse and Emit Specular” on page 103.

Decay Rate

Controls how quickly the light’s intensity decreases with distance. The 
Decay Rate setting has no effect at distances less than 1 unit. The 
default setting is No Decay.

For more information on light decay, see ”Light decay” on page 18.

In the Attribute Editor, click the arrow to display the drop-down list 
and select a Decay Rate. In the options window, type a value or use 
the slider.

Tip The Decay Rate also controls how fog brightness decreases 
with distance from the light source.
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Reference > mental ray Area Light Attributes
mental ray Area Light Attributes

For a description of mental ray for Maya’s area light, see ”mental ray Area 
Light” on page 17.

Type

This is the shape of the area light source. Select from the drop-down 
list: Rectangle, Disc, Sphere, Cylinder. The default is Rectangle.

Sampling

This represents the number of sample points emitted from the light (X 
and Y). The default is 3 and 3. Values greater than 3 increase the 
quality by reducing graininess, but may increase rendering cost.

Low Level

If this value is greater than 1 the light source uses the Low Sampling 
values instead, as long as their sum is greater than the Low Level 
value. This affects reflection and refraction. The default is 0.

Low Sampling

The default is 2 and 2.

Visible

This can be used if you want the area light object to be visible when 
rendered. The default is off.

No Decay no decay; light reaches everything

Linear light intensity decreases directly (linearly) with distance 
(slower than real world light)

Quadratic light intensity decreases proportionally with the square of 
distance (the same as real world light)

Cubic light intensity decreases proportionally with the cube of 
distance (faster than real world light)

Note If you’re using Maya’s Ray trace Shadows, make sure your 
Ray Depth Limit is greater than 1 so that reflected shadows 
appear. 
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Reference > Point Light Attributes
Point Light Attributes

For a description of Maya’s Point Light, see ”Create > Lights > Point 
Light” on page 95.

Type

See ”Type” on page 102.

Color

See ”Color” on page 102.

Intensity

See ”Intensity” on page 102.

Illuminates by Default

See ”Illuminates by Default” on page 103.

Emit Diffuse and Emit Specular

See ”Emit Diffuse and Emit Specular” on page 103.

Decay Rate

See ”Decay Rate” on page 104.

Spot Light Attributes

For a description of Maya’s Spot Light, see ”Create > Lights > Spot Light” 
on page 96.

Spot light Light Shape sample

Spot light tabs in the Attribute Editor also contain a Light Shape sample. 
This sample displays the shape the spot light casts and the light’s 
intensity. The following shows the default shape and intensity.

Type

See ”Type” on page 102.

Color

See ”Color” on page 102.

Intensity

See ”Intensity” on page 102.
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Reference > Volume Light Attributes
Illuminates by Default

See ”Illuminates by Default” on page 103.

Emit Diffuse and Emit Specular

See ”Emit Diffuse and Emit Specular” on page 103.

Decay Rate

See ”Decay Rate” on page 104.

Cone Angle

The angle (in degrees) from edge to edge of the spot light’s beam. The 
valid range is 0.006 to 179.994. The default value is 40.

Penumbra Angle

The angle (in degrees) from the edge of the spot light’s beam over 
which the intensity of the spot light falls off linearly to zero. The valid 
range is -179.994 to 179.994. The slider range is -10 to 10. The default 
value is 0.

For example, if the Cone Angle value is 50 and the Penumbra Angle 
value is 10, the spot light has an effective spread of 70 (50 + 10 + 10) 
degrees; however, the spot light intensity decreases to 0 between the 
angles of 50 and 70 degrees. If the Cone Angle value is 50 and the 
Penumbra Angle value is -10, the spot light has an effective spread of 
50 degrees and the spot light intensity decreases to 0 between the 
angles of 30 and 50 degrees.

Dropoff

Controls the rate at which light intensity decreases from the center to 
the edge of the spot light beam. The valid range is 0 to ∞. The slider 
range is 0 to 255. 

Typical values are between 0 and 50. Values of 1 or less produce 
almost identical results (no discernible intensity decrease along the 
radius of the beam). The default value is 0 (no dropoff).

Volume Light Attributes

For a description of Maya’s Volume Light, see ”Create > Lights > Volume 
Light” on page 97.

Type

See ”Type” on page 102.

Color

See ”Color” on page 102.
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Reference > Volume Light Attributes
Intensity

See ”Intensity” on page 102.

Illuminates by Default

See ”Illuminates by Default” on page 103.

Emit Diffuse and Emit Specular

See ”Emit Diffuse and Emit Specular” on page 103.

Light shape 

This determines the volumetric shape of the light. Select a light shape 
from the drop-down list: Box, Sphere, Cylinder, or Cone. Sphere is the 
default.

There is a volume 
light and an 
ambient light in 
this scene.

The volume light 
is being used to 
simulate the light 
of the candle, 
which can only 
illuminate objects 
for a finite 
distance. 

By adjusting the 
scale of volume 
light, you can 
control how far 
the light reaches 
into the scene.

To control the 
falloff within this 
light, we’ve added 
indices to the 
color range 
attribute's ramp 
control.

You can pinpoint 
where the volume 
light ends near 
the top - it’s 
where the detail in 
the image 
lessens.
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Reference > Volume Light Attributes
Color range attributes

colorRange

The colorRange is the color of the light from the center to the edge of 
the volume. By changing the values on the ramp (gradient) you can 
decay or change color along the defined light direction. The right side 
of the ramp represents the light color at the center of the volume. The 
left side is the color at the outer boundary. The effect of decay is 
accomplished by the interpolation (blend) from the inner color to the 
outer color. The outermost color should be black to avoid a hard 
boundary at the volume edge.

Selected Position

Position of the active color entry in the ramp. 

Selected Color

The color of the active color entry.

Interpolation

Controls the way colors blend in the ramp. Select an option from the 
drop-down list: None, Linear, Smooth, Spline. The default is Linear. 

None There is no interpolation; the different colors show 
up as different bands in the final texture. 

Linear The values are interpolated linearly in RGB color 
space. 

Smooth The values are interpolated along a bell curve, so 
that each color on the ramp dominates the region 
around it, then blends quickly to the next color. 

Spline This takes into account neighboring indices for a 
smoother effect.

Click to delete the 
color entry.

Click the handle to edit 
the color entry.

Drag the handle to 
move the color entry.

Click in the ramp to add a 
new color entry or drag to 
add and interactively 
position a new color entry.
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Reference > Volume Light Attributes
Volume Light Dir

The direction of the light within the volume. Select an option from the 
drop-down list: Outward, Inward, Down Axis. The default is 
Outward. 

Outward 

Light moves away from the center of a box or sphere and away from 
the central axis of a cylinder or cone. It behaves like a point light.

Inward 

The light direction moves towards the center of the light. This is a 
special effect that does not simulate an area light, but is instead a 
simple change in direction used for the light computation.

Down Axis 

The light direction is down the central axis of the light. It behaves like 
a directional light.

Arc

Use this option to create a partial sphere, cone, or cylinder light shape 
by specifying a degree of rotation. Values can range from 0 to 360 
degrees. The most common settings are 180 and 360, the default. 180 is 
similar to slicing the light volume in half and 360 is the full light. This 
option does not apply to the box light shape.

Cone End Radius

This option applies to the cone light shape only. This is the relative 
size of one end of the cone. At a value of 1.0 it is a cylinder, while at 0 
it is a cone. 

Emit Ambient

If turned on, light affects surfaces in a multi-directional manner. The 
default is off. 

Note Shadowing does not work properly for directions other 
than Outward. It always shadows as if from a point light.

Emit Specular has no effect on Inward lights.
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Reference > Volume Light Attributes
Penumbra attributes

Penumbra

This section applies to cone and cylinder light shapes only. This contains 
attributes for managing the penumbra, the area of partial illumination 
around the shadow border and the light. Using the graph you can adjust 
the spread and the dropoff of the light. The left side of the graph 
represents the intensity at the outer edge of the cone or cylinder and the 
right side represents the intensity from the center of the beam to the edge.

Selected Position

This value affects the active entry in the graph and is represented on 
the x-axis of the graph.

Selected Value

This value affects the active entry in the graph and is represented on 
the y-axis of the graph. 

Note Emit Ambient may wash out shadows and look flat. 

When combined with Emit Diffuse, the lighting of a surface 
is 50% of the surface/light angle, and 50% in a non-
directional fashion. If Emit Diffuse is off then the light is 
totally omnidirectional.

If Emit Diffuse and Emit Specular are off and Emit Ambient 
is on, the light behaves like an ambient light with decay and 
a bounded range. This is quite useful for adjusting lighting. 
It can be used with negative light intensity to pull light out 
of defined regions.

Click to delete the 
entry.

Click the handle to edit 
the entry.

Drag the handle to 
move the entry.

Click in the graph to add a 
new entry or drag to add 
and interactively position a 
new entry.
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Reference > Volume Light Attributes
Interpolation

This controls the way the values are calculated. Select an option from 
the drop-down list: None, Linear, Smooth, Spline. The default is 
Linear. 

None There is no interpolation; the different values show 
up as different bands in the final result. 

Linear The values are interpolated linearly. 

Smooth The values are interpolated along a bell curve, so 
that each value on the ramp dominates the region 
around it, then blends quickly to the next value. 

Spline This takes into account neighboring indices for a 
smoother effect. 

Multiple Positions at 
different Values on 
the penumbra graph 
can be used to 
create rings of light. 
This could be used 
to simulate the light 
effect of a flash light.
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Reference > mental ray attributes (point, spot, directional)
mental ray attributes (point, spot, directional)

mental ray attributes are available only for point, spot and directional lights. 

Caustic and Global Illumination

Emit Photons

Turns on photon emission for the light source.

Energy

The amount of light distributed by the light source. Each photon 
carries a fraction of the light source energy. 

8000 is the default. 0 means no photons are emitted. 

If caustic effects are not bright enough, try increasing these values 
equally, in small increments (to 12000, to start) until you have better 
results. 

Linear 
interpolation

No interpolation

Smooth 
interpolation

Spline 
interpolation
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Reference > Image based lighting node attributes
If ‘hot spots’ (blown out) areas occur, try decreasing these values 
equally to around 4000 or 5000.

Exponent

This is similar to decay—the intensity increases as the value decreases. 
To increase the chances that indirect light will reach a greater distance, 
decrease the value. 

Visible noise can occur with values less than 1. The default (2) 
simulates natural (quadratic) decay, but violates the conservation-of-
energy law (that happens in the natural world), so bright spots from 
distant light sources could occur in unexpected locations.

Physical

Ensures shading models in the scene behave in a physically correct 
way. That is, they do not amplify light beams emitting more energy 
than was received. This is particularly important if you are combining 
Global Illumination with Final Gather. 

Caustic Photons

The number of photons to be generated by the light source and 
therefore stored in the photon map. The default, 10000, is suitable for 
quick, low-quality caustics. To improve the quality of caustic effects, 
increase this number, incrementally, to 20000 to start (render time will 
increase as a result). Generally, 100000 produces medium quality and 
1000000 produces highly accurate effects. 

Image based lighting node attributes

These are descriptions of the attributes in the mental ray Ibl (Image based 
lighting) node. See ”Image-based lighting (sky-like illumination)” on 
page 33 and also ”Render infinitely distant (sky-like) illumination and 
reflection” on page 74.

Image Based Lighting Attributes

These are the attributes in the Image Based Lighting Attributes section.

Hardware Filter

Sets texture filter quality for shaded view: nearest or linear. 

Hardware Alpha

Sets transparency of IBL shape locator in shaded view. 0 is 
transparent, 1 is fully opaque. 
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Reference > Image based lighting node attributes
Color Gain, Color Offset, Invert, Alpha Is Luminance

These attributes are the same as those of Maya's texture node. They 
apply in similar ways to IBL. 

Mapping

Select a UV space for the environment sphere: spherical (latitude-
longitude) or angular (HDR Shop). 

Type

Select whether to map a file or a procedural texture as the IBL texture. 
File textures can be previewed interactively. See also Texture.

Image Name

If Type is set to File Texture, name of file on disk. 

Use Frame Extension

If turned on, the texture's file name may change on a per-frame basis. 
This is used to load an image sequence instead of a single file. 

Frame Extension

The frame extension. 

Texture

If Type is set to Procedural, connect a 2D texture shading network to 
this input. 

Render Stats

Controls the IBL texture's visibility to certain ray types. This maps to a 
camera environment shader in mental ray. If all controls are deactivated, 
then no environment shader is processed. For classical image based 
lighting, the IBL texture must be visible to final gather rays and Final 
Gather must be on.

Primary Visibility

When on, the surface is visible in the view and renders.

Visible as Environment

When on, the surface is visible to environment rays (direct reflection 
of the environment). This attribute is off by default, unless you created 
the IBL node from the mental ray Render Global Settings window.

Visible in Secondary Reflections

When on, the surface is visible to secondary reflection rays. This 
attribute is off by default, unless you created the IBL node from the 
mental ray Render Global Settings window.
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Reference > Image based lighting node attributes
Visible In Refractions

When on, the surface refracts in transparent surfaces.

Visible In Final Gather

When on, the surface is visible to Final Gather rays and is used to 
illuminate the scene. When off, IBL does not affect final gathering. 
This attribute is off by default, unless you created the IBL node from 
the mental ray Render Global Settings window.

Light Emission

These are the attributes in the Light Emission section.

You can emit light from the IBL environment radially inward toward the 
origin (of world space). If light emission is turned on, the IBL node acts 
like true light sources in the scene. The IBL texture is mapped to a mental 
ray light shader just like a real light source would be. 

Emit Light

Turn on, if you want to emit light from the infinitely distant IBL 
environment. 

Quality U, Quality V 

The light shader sets up a “control texture” for light emission. Every 
pixel in that texture virtually represents a directional light. These 
values specify the control texture's resolution. Higher values offer 
more precision but are more processor intensive. Loaded IBL textures 
are downsampled to the filter resolution; procedural textures are 
sampled at this resolution in pixel units for optimum performance.

Samples

Sampling all “directional lights” represented by the control texture is 
often prohibitively expensive. Therefore the shader has a built-in 
importance mechanism that attempts to select the primary (key) 
lights. 

The first Samples parameter specifies the number of important lights 
that must be sampled. The second parameter quasi-randomly selects a 
certain number of secondary (fill) lights. 

Low samples

Low Samples specifies the number of light samples taken from IBL 
during final gathering. It defaults to 1/8th of the regular samples (that 
is, 5/2).
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Reference > Image based lighting node attributes
Vary Focus 

Each “directional light” in the control texture sphere determines its 
direction. Turning on Vary Focus slightly offsets that direction 
(randomly) and thus improves quality. 

Disable Backlighting

If lights on the backside of surfaces do not contribute to the surfaces' 
illumination (i.e., there is no translucency in the scene), you should 
turn this on. It optimizes sampling significantly. 

Emit Diffuse, Emit Specular, Use Ray Trace Shadows, Shadow Color, 

Ray Depth Limit

These parameters are identical to attributes on Maya's standard lights. 

Photon Emission

These are the attributes in the Photon Emission section.

Photons can be emitted from the IBL environment sphere. This requires 
Global Illumination and, or Caustic photons to be turned on in the Render 
Global Settings window. The emission direction is chosen randomly for 
individual photons. Similar to light emission, a photon picks up the color 
based on its emission direction from the IBL texture (file or procedural), 
possibly adjusted by color gain and offset. The results of this maps to a 
mental ray photon emission shader. 

Emit Photons

Turn on, if you want to emit photons from the infinitely distant IBL 
environment. 

Globillumination

Determines how many global illumination photons are emitted. 

Caustic Photons

Determines how many caustic photons are emitted. 

Exponent

Determines the exponent used for photon emission. 

Standard emission

If off, photons will be stored on first hit. This is useful if IBL is to be 
achieved using global illumination photons alone. In terms of a real-
world environment you can think of this switch as photons from the 
Sun being scattered in the atmosphere before reaching any surface.

Turn this option on, if you are emitting caustic photons, or if you are 
emitting light in combination with photons. 
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Reference > Light Effects
Light Effects

The Light Effects attributes control the appearance of illuminated (light) 
fog and optical light effects. (For information on optical effects, see 
”Glows, halos, and lens flares” on page 20 and ”Optical FX Attributes” on 
page 131.)

Light Fog

Light Fog attributes are only available for point, spot and volume lights. 

When you click the map button beside Light Fog, Maya creates a light 
fog node and connects it to the light. A fog icon, basically an extension 
to the light icon, appears in the views. After you have connected Light 
Fog to a light, click the button at the end of the field to access the light 
fog attributes.

The following examples show a Light Fog applied to a Spot light 
using the default settings of 1.0, and the “Fog Spread” and “Fog 
Intensity” setting changed to 2.0.

Note Avoid instanced lights when you create light fog. Copy the 
lights instead of instancing. For light fog, make sure that 
light fog is duplicated independently of the light because 
when you duplicate a light, its light fog is not duplicated 
with it.
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Reference > Light Effects
Fog Spread

Only for spot lights.

Determines how the fog brightness varies across the spot light or 
point light beam . A high Fog Spread value produces fog with 
uniform brightness shooting from the cone of a spot light. A low Fog 
Spread value produces fog which is brighter at the center of the spot 
light beam and foggier at the end.

The slider range for a spot light is 0 to 5. The default value is 1. 

Fog Type

Only for point lights.

Select a Fog Type from the drop-down list. Fog types include:

Normal The default fog setting. 

Linear Fog slowly diminishes from the center of the light.

Exponential Fog quickly diminishes from the center of the light.

Fog Radius

Only for point lights.

The Fog Radius value determines how much the fog spreads in every 
direction from a point light’s beam. The spot or point light’s Decay 
Rate controls how fog brightness decreases with distance from the 
light source.

Note By default light fog is evaluated only at the boundary entry 
point. When the radius of the light fog is greater than the 
size of the volume fog, the amount of light illuminating the 
fog is the light intensity at the edge of the volume light 
(zero by default, but can be otherwise if the color ramp is 
edited). If you turn on Volume Samples Override on the 
Shape node (for example, sphereShapeNode) and increase 
the number of samples, the illumination of the volume light 
is better represented. Turning on Depth Jitter for the 
samples avoids stepping in these cases.

Normal Linear Exponential
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The slider range for a point light is 0 to 10.The default value is 1.

Fog Intensity

The brightness of the fog. (The light’s Intensity also influences the 
brightness of illuminated fog.) The slider range is 0 to 5. The default 
value is 1.

Light Glow

The Light Glow attribute is available for point, spot, area and Volume 
lights only.

When you click the map button beside Light Glow, Maya creates an 
optical FX node and connects it to the light (a glow, halo, or lens flare). 
An optical FX icon attached to the light icon appears in the views. See 
”Optical FX Attributes” on page 131 for details about setting these 
attributes. 

Intensity Curve

Only for spot lights.

Creates an intensity curve used to control the intensity decay for a 
spot light. This attribute is only available for spot lights. See also 
“Create custom spot light intensity or color decay” and “Edit custom 
intensity and color decay”.

Color Curves

Only for spot lights.

Creates a color curve used to control how a spot light’s color changes 
with distance. 

See also “Create custom spot light intensity or color decay” and “Edit 
custom intensity and color decay”.

Glow attached to a Point light.
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Reference > Shadow attributes
Barn doors

The Barn Doors attributes are located in the Light Effects section of a 
spot light’s Attribute Editor and are used to square off the circular 
shape of a cone. 

Left, Right, Top, 

Bottom Barn Door  The angle (in degrees) from the center of the spot 
light’s beam to the position of each barn door. The 
valid/slider range is -89.997 to 89.997. The default 
value is 20.

Decay Regions attributes

The Decay Regions attributes let you separate a spot light’s beam into 
regions which are illuminated and regions which are not illuminated. 

Click Use Decay Regions to turn it on and to set the Region 1, 2 and 3 Start 
and End distances for the spot light. Use Decay Regions is off by default. 

Related topics

� ”Light decay” on page 18

� ”Decay Rate” on page 104

Region 1, Region 2, and Region 3 attributes

The Region 1, Region 2, and Region 3 attributes control the size and 
location of each illuminated region within a spot light’s beam.

Start Distance1, End Distance1

The Start and End Distance values determine the distance from the 
spot light where each illuminated region begins and ends.

Shadow attributes

For more information about shadows, see ”Shadow” on page 34.

Note  You can adjust barn door interactively. See ”Apply barn 
doors (shutters) to a beam of light” on page 55.

Note  You can adjust decay interactively. See ”Interactively set 
decay regions” on page 51.
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Shadow Color

The color of shadows produced by the light. Use a colored shadow to 
simulate shadows produced by transparent, colored surfaces (for 
example, colored glass). The default setting is black.

You can also map textures to shadows to create interesting effects. The 
following example shows a Checker texture mapped to the Shadow 
Color of a Spot Light. 

If you decide to map a texture that has color (such as the Stucco 
texture in the following example), change the texture’s color to black 
and white if desired.

Depth Map Shadow Attributes

The Depth Map Shadow Attributes control the appearance of depth map 
shadows produced by the light.

For more information about depth map shadows, see ”Depth map 
shadows” on page 36.

Use Depth Map Shadows

If Use Depth Map Shadows is on, the light produces depth map 
shadows. Use Depth Map Shadows is off by default.

Dmap Resolution

The resolution of the light’s shadow depth map.
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If the Dmap Resolution is too low, shadow edges appear jagged or 
pixelated. Increasing the Dmap Resolution also increases rendering 
times, so set it to the lowest value that produces shadows of 
acceptable quality. 

As a starting point, set Dmap Resolution to the rendering resolution. 
If the light moves during an animation, you may need to increase the 
Dmap Resolution to avoid flickering shadows. The slider range is 16 
to 8192. The default value is 512.

Use Mid Dist Dmap

If off, Maya calculates the distance from the light to the nearest 
shadow casting surface for each pixel in the depth map. If the distance 
from the light to another shadow casting surface is greater than the 
depth map distance, that surface is in shadow.

If on, for each pixel in the depth map, Maya calculates the distance 
from the light to the nearest shadow casting surface and the distance 
from the light to the next nearest shadow casting surface and averages 
them.

If the distance from the light to another shadow casting surface is 
greater than the depth map distance, that surface is in shadow. Use 
Mid Dist Dmap is on by default.

Note If Use Mid Dist Dmap is off, dark spots or streaks may 
appear on illuminated shadow casting surfaces because the 
distance from the light to the surface is greater than the 
stored depth value and therefore in shadow. This type of 
artifacting happens because of the finite resolution of some 
dmaps and may be particularly noticeable for a curved 
surface, or for a surface illuminated by light not 
perpendicular to the surface. 

A pixel in the dmap can be forced to approximate a large 
area of the scene. Although you can reduce this effect by 
increasing the Dmap Resolution, you are only making the 
problem smaller. This also increases rendering times. A 
better solution is to turn on Use Mid Dist Dmap.

Note If Use Mid Dist Dmap is on, Maya calculates the middle 
distance between shadow casting surfaces only (that is, 
surfaces which have their Casts Shadows attribute on).
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Use Dmap Auto Focus

If on, Maya automatically scales the depth map so that it only fills the 
area of the light’s illumination that contains shadow casting objects. 

For example, if shadow casting objects are only in the center of a spot 
light’s beam, the depth map only covers the region occupied by those 
objects. Because the Dmap Resolution is an absolute resolution (that 
is, pixels, not pixels per inch), decreasing the size of the depth map 
effectively increases the resolution of the depth map and the quality of 
the shadows without increasing rendering times.

If off, you can manually scale the depth map within the area of the 
light’s illumination using the Dmap Focus attribute (for point lights 
and spot lights) or the Dmap Width Focus attribute (for directional 
lights). Use Dmap Auto Focus is on by default.

Dmap Focus, Dmap Width Focus

The angle (Dmap Focus) or width (Dmap Width Focus) to scale the 
depth map within the area of the light’s illumination. (You can scale 
the depth map automatically by turning on Use Dmap Auto Focus.) 

Because the Dmap Resolution is an absolute resolution (that is, pixels, 
not pixels per inch), decreasing the size of the depth map effectively 
increases the resolution of the depth map and the quality of the 
shadows without increasing rendering times.

Dmap Focus is only available for point lights and spot lights if Use 
Dmap Auto Focus is off. The slider range is 0 to 360. The default value 
is 90.

Dmap Width Focus is only available for directional lights if Use Dmap 
Auto Focus is off. The valid range is 0 to ∞. The default value is 100.

Use Light Position

Use Light Position is only available for directional lights. If on, only 
objects in front of the directional light's icon are lit and cast shadows. 
If off, objects both in front of and behind the directional light's icon 
are lit and casts shadows.

Use Light Position is only available for directional lights. Use Light 
Position is off by default.

Dmap Filter Size

Controls the softness of shadow edges. (The softness of shadow edges 
is also influenced by the size of the shadow and the Dmap 
Resolution.) Increasing Dmap Filter Size also increases rendering 
times, so set it to the lowest value that produces acceptable results. A 
Dmap Filter Size of 3 or less is usually sufficient. The valid range is 0 
to ∞. The slider range is 0 to 5. The default value is 1.
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Dmap Bias

Offsets the depth map toward or away from the light. Adjust the 
Dmap Bias only if you encounter the following problems and cannot 
resolve them by adjusting other attributes:

• If dark spots or streaks appear on illuminated surfaces, gradually 
increase the Dmap Bias value until the spots or streaks disappear.

• If a shadow appears to be detached from the shadow casting 
surface, gradually decrease the Dmap Bias value until the shadow 
looks correct.

The slider range is 0 to 1, but you can type in a higher value. The 
default value is 0.001.

Fog Shadow Intensity

Controls the darkness of shadows appearing in illuminated (light) fog. 
The valid range is 1 to 10. The default value is 1.

Fog Shadow Samples

Controls the graininess of shadows appearing in illuminated (light) 
fog. Increasing Fog Shadows Samples also increases rendering times, 
so set it to the lowest value that produces acceptable results. Shadows 
that are cast from very narrow objects into illuminated fog may shift 
during an animation. In this case, increase the Vol Shadow Samples 
value. The default value is 20.

Disk Based Dmaps

Lets you save a light’s depth maps to disk and reuse them during 
subsequent renders. By saving depth maps to disk, and reusing them 
later, you can decrease the time it takes to render the scene (see 
”Reuse depth maps” on page 78). Depth maps are saved in the 
renderDate/depth directory.

Off Maya creates new depth maps during rendering. 
Maya does not read depth maps from disk. Maya 
does not save depth maps to disk.

Overwrite Existing 

Dmap(s) Maya creates new depth maps, and saves them to 
disk. If depth maps already exist on disk, Maya 
overwrites them.

Tip If you want very soft shadows, use a low dmap resolution, 
then adjust this setting.
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When you write them to disk, you get two dmaps: 
One is the first shadow casting surface, the other is 
the second shadow casting surface.

Reuse Existing 

Dmap(s) Maya checks to see if depth maps have previously 
been saved to disk. If so, Maya uses them instead of 
creating new depth maps. If not, Maya creates new 
depth maps and saves them to disk.

Dmap Name

The name of the depth map file that Maya saves to disk. The name of 
the depth map may also include the scene name (if Dmap Scene Name 
is on), the light name (if Dmap Light Name is on), and the frame 
extension (if Dmap Frame Ext is on). Dmap Name is only available if 
Disk Based Dmaps is set to either Overwrite Existing Dmap(s) or 
Reuse Existing Dmap(s). Depth maps are saved in the renderDate/
depth directory. The default depth map name is depthmap.

Dmap Scene Name

Adds the scene name to the name of the depth map file that Maya 
saves to disk. Dmap Scene Name is off by default.

Dmap Light Name

Adds the light name to the name of the depth map file that Maya 
saves to disk. Dmap Light Name is on by default.

Dmap Frame Ext

If on, Maya saves a depth map for each frame, and adds the frame 
extension to the name of the depth map file. If off, Maya saves one 
depth map file for the entire animation and does not add the frame 
extension to the name of the depth map file. Dmap Frame Ext is off by 
default.

Dmap Use Macro

Only available when Disk Based Dmaps is set to Reuse Existing Dmap(s). 
The path and name of a macro script that Maya runs to update a 
depth map when it reads it from disk. Dmap Use Macro is useful 
mainly for troubleshooting. 

Tip If you are saving depth maps to disk, check the 
renderDate/depth directory occasionally, and remove any 
unnecessary depth map files.
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The macro gets all the information for creating or processing depth 
maps on disk. The following example is written in Perl. The macro 
post-processes or creates the maps. You can modify or create maps of 
any width or height. Maya looks at the sizes specified in the IFF Z-
depth map file and uses them. The macro is called each time a map is 
going to be read from disk. For example, the map may be called 
several times in the case of a point light, which can use up to six maps.

The arguments are named so that new arguments can be added easily. 
The arguments currently supplied to the script by Maya are:

mapname=FullPathMapName,middistmapname=FullPathMidDistMapName,
lightname=LightShapeNameUsed,pathname=ShadowMapPathUsed,
readanimextname=RedExtUsed,curranimextname=CurrExt,
lastdumpanimextname=lastExtDumped,bias=biasValue

An example of a Perl script macro is as follows:

#!/bin/perl
#
# Example of a callback macro called before reading shadow maps from disk
#

#
# One argument with fields separated by '&'
# each field being 'variableName=variableValue
#
# Creates a vartab hash table out of the ARGV[0] argument
#

# print "\n------------------\n",$ARGV[0],"\n------------------\n";

if( $#ARGV == 0 )
{

@fields = split( /\,/, $ARGV[0] );
$nbfields = $#fields + 1;
foreach $field( @fields )
{

@varvalue = split( /\=/, $field );
$vartab{$varvalue[0]} = $varvalue[1];

}

$mapname = $vartab{"mapname"};
$middistmapname = $vartab{"middistmapname"};
$lightname = $vartab{"lightname"};
$pathname = $vartab{"pathname"};
$readanimextname = $vartab{"readanimextname"};
$curranimextname = $vartab{"curranimextname"};
$lastdumpanimextname = $vartab{"lastdumpanimextname"};
$bias = $vartab{"bias"};
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print "\tmapname = ",$mapname,"\n";
print "\tmiddistmapname = ",$middistmapname,"\n";
print "\tlightname = ",$lightname,"\n";
print "\tpathname = ",$pathname,"\n";
print "\treadanimextname = ",$readanimextname,"\n";
print "\tcurranimextname = ",$curranimextname,"\n";
print "\tlastdumpanimextname = ",$lastdumpanimextname,"\n";
print "\tbias = ",$bias,"\n";

#
# List the shadow map files to be postprocessed
#

print "\n";
if ( -e $mapname ) {

print "PostProcess shadow depth map file ",$mapname,"\n";
}
if ( -e $middistmapname ) {

print "PostProcess shadow depth map file ",$middistmapname,"\n";
}

#
# return 0 to confirm everything is ok
#

exit 0;
}

Use Only Single Dmap

Only available for spot lights. 

If on, Maya generates a single depth map for the spot light. A single 
depth map is usually sufficient if the Cone Angle is less than 90, but if 
the Cone Angle is large, the Dmap Resolution may not be high 
enough to produce high quality shadows (shadow edges may appear 
jagged). If the Cone Angle is large, turn off Use Only Single Dmap. 
Use Only Single Dmap is on by default.

If off, Maya generates up to five separate depth maps for the spot 
light. Each depth map extends from the light in one of six possible 
directions: positive or negative X-axis directions, positive or negative 
Y-axis directions, and positive or negative Z-axis directions. The 
resolution of each depth map is the Dmap Resolution.

The spot light also produces high quality shadows even if the Cone 
Angle is large. Rendering times may also increase because Maya is 
generating several depth maps for the light. However, you can control 
the number and direction of depth maps that Maya generates by 
turning the Use XYZ+- Dmap attributes on or off.
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Use X+ Dmap, Use Y+ Dmap, Use Z+ Dmap, Use X- Dmap, Use Y- 

Dmap, Use Z- Dmap

These attributes are only available for spot lights (if Use Only Single Dmap 
is off) and point lights. The default setting for all attributes is on.

Control the number and direction of depth maps Maya generates for 
the light. For example, if X+ Dmap is on, Maya generates a depth map 
for the light in the direction of the positive X-axis. 

Maya can generate up to five depth maps for a spot light and up to six 
depth maps for a point light. However, you usually only need the 
light to cast shadows in a few specific directions. By turning off depth 
maps in certain directions, you can help reduce rendering times. For 
example, if there is a point light at the top of the scene, and all shadow 
casting objects are below the light, you can turn off Use Y+ Dmap 
(assuming the scene uses a Y-up coordinate system) and Maya does 
not generate a depth map in the direction of the positive Y axis (up).

Raytrace Shadow Attributes

Control the appearance of raytraced shadows produced by the light.

For more information about raytraced shadows, see ”Raytraced shadows” 
on page 37.

Use Ray Trace Shadows

If on, the light produces raytraced shadows when the scene is raytraced 
(that is, when Raytracing is on in the Render Global Settings window). 
Use Ray Trace Shadows if off by default.

Shadow Radius, Light Radius, Light Angle

Controls the softness of shadow edges by setting the size (Shadow 
Radius or Light Radius) or angle (Light Angle) of the light. For 
example, a large light produces softer shadows than a small light. The 
light radius is also used for light glows to determine the occlusion/
visibility (for point and spot lights). 

The Shadow Radius attribute is only available for ambient lights. 

The Light Radius attribute is only available for point lights and spot 
lights. The slider range is 0 (hard shadows) to 1 (soft shadows). The 
default value is 0.

The Light Angle attribute is only available for directional lights. The 
slider range is 0 (hard shadows) to 180 (soft shadows). The default 
value is 0.
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Shadow Rays

Controls the graininess of soft shadow edges. Increasing the number 
of Shadow Rays also increases rendering times, so set it to the lowest 
value that produces acceptable results. The slider range is 1 to 40. The 
default setting is 1.

Ray Depth Limit

Ray depth specifies the maximum number of times a light ray can be 
reflected and, or refracted and still cause an object to cast a shadow. 
Transparent objects between those points in which the ray changes 
direction will have no affect on the light ray's termination. This can 
best be visualized by example in which the ray traced shadow is 
visible on both the ground plane and reflection plane. If the ray depth 
is set to 1, the shadow will only be visible on the ground plane. If the 
ray depth is set to 2, the shadow will be visible on both the ground 
plane and the reflected plane.

shadow-catching 
plane

reflection plane

eye

shadow-casting 
sphere

light
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Glow nodes

Optical FX Attributes

The Optical FX Attributes control the appearance of glows, halos, and lens 
flares.

For more information about optical effects, see ”Glows, halos, and lens 
flares” on page 20.

Active

Turns the optical effect on or off. Active is on by default. 

Lens Flare

Simulates a bright light source illuminating the surfaces of a camera’s 
lens. The flare intensity is determined by the “Flare Intensity” value. 
The size of the flare circles is relative to the field of view of the 
camera. Lens Flare is off by default. Check Lens Flare on to access 
Lens Flare Attributes.

Glow Types

The type of glow the light produces when viewed directly. Click the 
arrow to access available glow types from the drop-down list.

A light does not need glow to illuminate objects when the scene is 
rendered, however a light does need glow to be visible by the camera 
when the scene is rendered. The default Glow Type is Linear.

The following examples show a yellow glow (Glow Color) and all 
other Glow attributes left at the default settings.

None No glow appears.

Linear Glow slowly diminishes from the center of the light.
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Exponential Glow quickly diminishes from the center of the 
light.

Ball Glow diminishes faster towards a distance (from the 
light center) specified by the Glow Spread value.

Lens Flare Simulates a bright light source illuminating the 
surfaces of several camera lenses.

Rim Halo Forms a circular ring with a soft central glow. The 
size of the ring is determined by the Halo Spread 
value (in this example, 0.75).
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Halo Types

The type of halo the light produces when viewed directly. Halo is 
similar to Glow, except that the fall off is more gradual and different 
fall-off types are available. The default setting is None. Click the 
arrow to access the drop-down list.

The following show the different Halo types with the default Linear 
Glow Type, a red Halo Color, and the Halo Spread set to 0.75.

None No halo appears.

Linear Halo slowly diminishes from the center of the light.

Exponential Halo quickly diminishes from the center of the light.

Ball Halo diminishes faster towards a distance (from the 
light center) specified by the Halo Spread value.

Lens Flare Simulates a bright light source illuminating the 
surfaces of several camera lenses.
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Rim Halo Forms a circular ring with a soft central glow. The 
size of the ring is determined by the Halo Spread 
value.

Radial Frequency

Controls the smoothness of glow radial noise (see Glow Radial Noise). 
The slider range is 0 to 5, but you can enter values up to infinity. The 
default value is 0.5.

Star Points

Represents the number of points on glow star filter effects (see Glow 
Star Level). The following examples show a Star Points value of 20 
and a Star Points value of 1 which produces a comet-like effect. Use 
the Rotation attribute to adjust the comet’s tail.

The slider range is 0 to 10 but you can enter values up to infinity. The 
default value is 4.

Note A non-integer Star Points value could render with a seam 
or hard line at the top of a star effect. 
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Rotation

Rotates glow noise and star effects (“Glow Noise”, “Glow Radial 
Noise”, and “Glow Star Level”) about the center of the light. The 
slider range is 0 to 360 (degrees) but you can enter values up to 
infinity. The default value is 0.

Glow Attributes

Glow Color

The color of the light’s glow. Click the color swatch to open the Color 
Chooser and select a color if desired.The default setting is white.

Glow Intensity

Also accessible through the material’s Special Effects attributes (see 
the Shading guide for details). Controls the glow brightness. As the 
Glow Intensity value increases, so does the apparent size of the glow 
effect. A negative Glow Intensity value subtracts from other glows. 
(The light’s Decay Rate controls how the glow brightness decreases 
with distance.) The slider range is 0 to 10, but you can enter values up 
to infinity. The default value is 1.

Glow Spread

Controls the size of the glow effect. Negative values can have odd but 
sometimes useful effects. The slider range is 0 to 5. The default value 
is 1.

Glow Noise

Controls the strength of two-dimensional noise applied to the glow. 
The noise is generated on a plane centered at the location of the light 
and always oriented towards the camera. The slider range is 0 to 1. 
The default value is 0.

To create the illusion of illuminated smoke around a glowing light 
source, set the Glow Noise value to about 0.5 and slowly animate the 
Noise Uoffset and Noise Voffset values. The smoke appears to slowly 
drift by the light.

The following example shows how you can create a moody night sky 
simply by adjusting a few Glow Attributes. The Optical FX attributes 
used in this example are as follows:

Tip Generally, fog illumination is better than glow if you want 
to create smoke and fire effects because fog is a 3D effect 
(for example, glow noise cannot be occluded by objects).
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• Glow Type = Exponential

• Radial Frequency = 0 

• Star Points= 2 

• Rotation = 300

Glow Radial Noise

Randomizes the spread of the glow to simulate starburst effects and 
eyelashes refracting light. The slider range is 0 to 1. The default value 
is 0.

Negative values of Glow Radial Noise produce thicker noise. Use the 
“Radial Frequency” attribute to control the smoothness of this effect.

Glow Star Level

Simulates camera star filter effects. The slider range is 0 to 4. The 
default value is 0. Use the “Star Points” attribute to set the number of 
points on the star. Use the “Rotation” attribute to rotate the star.

Glow Opacity

Controls the amount the light’s glow obscures objects. Think of 
opacity as the opposite of transparency. The slider range is 0 to 0.5. 
The default value is 0.

Halo Attributes

Halo Color

The color of the halo. Click the color swatch to open the Color 
Chooser and select another color if desired. The default setting is 
white.

Map the Optical FX utility to a light’s
Color and change the Glow Attributes
to produce this effect.

Add a bump-mapped sphere 
to create a realistic-looking 
moonscape.
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Halo Intensity

Controls the halo brightness. As the Halo Intensity value increases, so 
does the apparent size of the halo effect. (The light’s Decay Rate 
controls how halo brightness decreases with distance.) The slider 
range is 0 to 5. The default value is 1.

Halo Spread

Controls the size of the halo effect. Halo size is generally larger than 
glow size when the Halo Spread and Glow Spread values are the 
same. The slider range is 0 to 5. The default value is 1.

Lens Flare Attributes

These attributes are only accessible if Lens Flare is turned on in Optical FX 
Attributes.

Flare Color

The color of the lens flare circles. Click the color swatch and select 
another color from the Color Chooser if desired. The default color is 
white. 

Flare Intensity

Controls the flare effect’s brightness. (The light’s Decay Rate controls 
how the lens flare brightness decreases with distance.) The valid range 
is 0 to ∞. The slider range is 0 to 5. The default value is 1.

Flare Num Circles

Represents the number of circles in the lens flare effect. The valid 
range is 0 to ∞. The slider range is 0 to 30. The default value is 20.

If the Flare Num Circles value is very large, rendering times may be 
long, especially if the Flare Min Size and Flare Max Size values are 
large and the Flare Color is textured.

Flare Min Size, Flare Max Size

The size of the circles is randomized between these two values. The 
valid range is -∞ to ∞. The slider range is 0 to 5. The default value is 
0.1 for Flare Min Size and 1 for Flare Max Size.

Hexagon Flare

Produces hexagonal-shaped flare elements (instead of circles).
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Flare Col Spread

Controls the hue amount of individual circles randomized about the 
Flare Color. The Flare Col Spread value has no effect if the Flare Color 
is not at least partially saturated (for example, not white or grey). The 
slider range is 0 to 1. The default value is 0.5.

Flare Focus

Controls the circle edge sharpness. The valid range is 0 (very blurry) 
to 1 (totally sharp). The default value is 0.6.

Flare Vertical, Flare Horizontal

Controls the axis of the flare effect relative to the center of the image. 
If the light source moves, the flare appears to rotate through this 
point. The slider range is -1 to 1. The default value is 1.

Flare Length

Controls the flare effect length relative to the light location. If Flare 
Length is small, all circles overlap the light. If Flare Length is large, 
the circles spread out across the image. The Flare Length value has no 
effect if the Flare Vertical and Flare Horizontal values are both 0. The 
slider range is 0 to 1. The default value is 1.

Noise Attributes

See also “Glow Noise”.

Noise Uscale, Noise Vscale

Scales glow noise in the horizontal (Noise Uscale) and vertical (Noise 
Vscale) directions. The slider range is 0 to 5. The default value is 1.

Tip You can use Noise Uscale and Noise Vscale to create 
layered fog or tall flames. Animate the Noise Uscale and 
Noise Vscale values from high to low values to make the 
noise appear to fly apart like an explosion.
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Noise Uoffset, Noise Voffset

Offsets glow noise in the horizontal (Noise Uoffset) and vertical 
(Noise Voffset) directions.

For example, you can animate the Noise Uoffset and Noise Voffset 
values to simulate smoke, rain, or snow moving past a light. Noise 
repeats after an offset of 1. The slider range is 0 to 1. The default value 
is 1 for Noise Uoffset and 0.5 for Noise Voffset.

Noise Threshold

The cutoff value for the noise. As the Noise Threshold value 
approaches 0, glow noise breaks up into smaller patches. The slider 
range is 0 to 1. The default value is 0.5.

Photon and final gather nodes

mapVizShape node

When you generate a photon or final gather visualization map, the 
mapVizShape shape node is added to the scene. Adjust the attributes of this 
node to change the visualization map. For more information, see ”Photon 
maps” on page 25 and also ”See the distribution of photons” on page 68.

Map File Name

Name of the photon or final gather map file to be created and saved.

Photon Visibility

If the map is a photon map, turning any of these options off hides the 
corresponding photon type. 

Options

Point Size

This is the size of light rays on the surface to be drawn in screen space.

Normal Scale

Each photon and final gather point has an associated normal that tells 
which side of a surface it is on. Raise Normal Scale above zero to 
display normals.

Tip You can use Noise Threshold to simulate globular clusters, 
ejecta from explosions, snow and rain effects, especially 
when the Noise Uscale and Noise Vscale values are high. 
You can also use it to make flames and smoke more patchy.
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Direction Scale

Raise Direction Scale to display the direction from which photons 
arrived on the surface. 

Search Radius Scale

Irradiance is estimated from a photon map by looking up photons 
within a certain radius. MapViz automatically determines a good 
search radius for visualization. That radius can be scaled by Search 
Radius Scale. 

Render Global Settings window

Caustics and Global Illumination

These are descriptions of the options in the Caustics and Global 
Illumination section in the mental ray tab of the Render Global Settings 
window.

Caustics

Turn caustics, lighting effects such as light patterns on the bottom of a 
pool of water, on or off. Default is off. Caustics are produced only by 
light sources that specify an energy explicitly. The material shader 
that receives the caustics must be set to receive caustics. 

Caustic Filter Type

Controls the sharpness of the caustics. 

Filtering increases the weight of photons that are close to the point of 
interest, a process that reduces the amount of blur at the edges of a 
caustic. 

Box  Generally makes caustics looks sharper. 

Cone Generally makes caustics looks smoother.

Caustic Filter Kernel

This specifies the size of the filter applied to caustic photons.

Caustic Accuracy

Controls the number of photons used to estimate the caustic 
brightness. The default is 64. Higher settings (up to 100 to start, tested 
in small increments) and larger numbers make the caustic smoother. 
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Caustic Radius

Controls the maximum distance at which mental ray for Maya 
considers photons for caustics. When left at 0 (the default), mental ray 
for Maya calculates an appropriate amount of radius, based on the 
size of the scene. If the result is too noisy, increasing this value (to 1, 
to start, then by small increments up to 2) decreases noise but gives a 
more blurry result. To reduce the blur, you must increase the number 
of caustic photons (Caustic Accuracy) emitted by the light source. 

Global Illumination

Use this to turn on or off Global illumination, a process that allows for 
indirect lighting and effects like color bleeding. The default is off. 
Global illumination is computed only for light sources that have an 
energy specified explicitly. The material shader that receives the 
caustics must be set to receive caustics.

Global Illum Accuracy

Change the number of photons used to compute the local intensity of 
global illumination. 

The default number is 64; larger numbers make the global 
illumination smoother but increase render time. 

Global Illum Radius

Controls the maximum distance at which mental ray for Maya 
considers photons for global illumination. When left at 0 (the default), 
mental ray for Maya calculates an appropriate amount of radius, 
based on the size of the scene. If the result is too noisy, increasing this 
value (to 1, to start, then by small increments up to 2) decreases noise 
but gives a more blurry result. To reduce the blur, you must increase 
the number of global illumination photons emitted by the light source. 

Photon Volume Accuracy

Controls how the photon map is used to estimate the intensity of 
caustics or global illumination within a participating medium. It 
applies to photon volume shaders, which compute light patterns in 
3D space, such as volume caustics created by focused shafts of light 
cast by objects acting as lenses. 

Photon Volume Radius

Controls the maximum distance at which mental ray for Maya 
considers photons for a participating medium. 

Max Reflection Photons

Use this to limit the number of times a photon will reflect in a scene. It 
works in conjunction with Max Photon Depth.
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Max Refraction Photons

Use this to limit the number of times a photon will refract in a scene. It 
works in conjunction with Max Photon Depth.

Max Photon Depth

Use this to limit the number of times a photon will bounce around 
(reflect or refract) after the first bounce (which is taken care of by 
direct illumination) in a scene. Default is 5, but correct value depends 
on how many surfaces the photon must go through or bounce off of 
before hitting a diffuse surface to stop. For example, if a photon goes 
through 6 transparent surfaces, the default 5 would produce incorrect 
results. After the depth trace limit has been met, photons are not re–
emitted and instead are absorbed.

Custom shaders may override these values. 

Photon Map File

Specify the photon map file that mental ray for Maya should use as 
the current photon map. It will be loaded and used without 
computing a new photon map. If the photon map file does not exist, 
one will be created and saved. 

Photon Map Rebuild

If a filename is specified for the photon map (in Photon Map File), the 
map is loaded and used (providing the file exists). If this option is 
turned on, any existing file will be ignored, and the photon map will 
be recomputed and an existing file will be overwritten. The default is 
off. In other words, if you want to build a map, turn this option on; if 
not, turn this option off and specify the file to be used in Photon Map 
File.

Enable Semi-transparent Shadows

If you want transparent shadows with caustics, turn this option on. 
Shadow shaders will be exported (they aren’t by default) making it 
possible.

Final Gather

These are descriptions of the options in the Final Gather section in the 
mental ray tab of the Render Global Settings window.

Final Gather

Use this to turn Final gathering for global illumination on or off. The 
default is off. Final gathering is a different means of calculating 
indirect illumination. For more information, see ”Final gather and 
HDRI” on page 29. 
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Precompute Photon Lookup

This option (which also turns on Final Gather) causes photon tracing 
to compute and store an estimate of the local irradiance at every 
photon location. This means that far fewer final gathering points are 
required because the photon map carried a good approximation of the 
irradiance in the scene -- mental ray for Maya can estimate irradiance 
with a single lookup, instead of many photons. In this case, photon 
tracing takes longer than before and requires slightly more memory, 
but rendering is faster. 

Final Gather Rays

Controls how many rays are shot in each final gathering step to 
compute the indirect illumination. The default is 1000 per sample 
point, but this tends to be high for test renders (renders can take 
hours). Test rendering at lower values, usually 100 or 200, is sufficient; 
higher values are required for final renders. Increasing the value 
reduces noise but also increases the rendering time. 

Min Radius, Max Radius

Max Radius and Min Radius control the size of the sampling region 
within which Final Gather rays search for irradiance information from 
other surfaces. 

With the default values, Maya calculates values that seem appropriate 
based on scene dimensions to speed up the render, but this calculation 
doesn’t allow for complex geometry. Generally, enter a value that is 
10% of scene’s overall dimension for the Max Radius, then enter 10% 
of that for Min Radius. Make further adjustments based on scene 
geometry detail, how the geometry is arranged in the scene, and how 
the render looks. For example, use these settings to achieve better 
diffuse detailing in nooks and crannies in your scene.

Note When the number of Final Gather rays is changed, the Final 
Gather File is always ignored and new Final Gather rays are 
emitted. 

You can see, in the Output window, when this happens: 

• RCFG 0.2 info: finalgMap/test1:final gather options 
differ from ones currently used, content ignored. 

• RCFG 0.2 info: overwriting final gather file "finalgMap/
test1" 
Lighting

143



1 | Lighting scenes
Reference > Final Gather
Final Gather Filter

Use this to control how Final Gather uses a speckle elimination filter 
to prevent samples with extreme brightness from skewing the overall 
energy stored in a Final Gather sampling region. 

Neighboring samples are filtered so that extreme values are discarded 
in the filter size. By default, the filter size is 1. Setting this to 0 disables 
speckle elimination, which can add speckles but will better converge 
towards the correct total image brightness for extremely low accuracy 
settings. Size values greater than 1 eliminate more speckles and soften 
sample contrasts. Sizes greater than 4 or so are not normally useful. 

Final Gather Falloff Start, Final Gather Falloff Stop

Use these settings to limit the reach of indirect light for Final Gather 
(but not photons). If no object is found within a distance of start, the 
ray defaults to the environment color. Objects farther away than stop 
from the illuminated point will not cast light. 

Final Gather Trace Depth

Use this option to specify the number of subrays for the final gather 
render. The default is 0, which means that indirect illumination 
computed by final gathering cannot pass through glass or bounce off 
mirrors, for example. A depth of 1 would allow a single refraction or 
reflection. Typically, a depth greater than 2 is not necessary. 

Final Gather File

This is the file that stores the Final Gather results that mental ray for 
Maya can use for irradiance lookups. You can reuse Final Gather 
results from a frame rendered earlier, or from a previous scene render:

• If no filename is specified and Final Gather Rebuild is turned on,   
rendered results are placed in a default file. 

• If you specify previously non-existent filename, the rendered 
results are placed in the file with that name.

• If you specify an existing filename here, and Final Gather Rebuild 
is turned on, the specified file is overwritten with the newly 
rendered Final Gather results.

• If you specify an existing filename here, and Final Gather Rebuild 
is turned off, the newly rendered results are appended to the 
existing file. (This means that the file may grow without bounds.)

Final Gather Rebuild

If this is on (default), any previously generated Final Gather file is 
ignored and all final gather points are recomputed. See Final Gather 
File for more information about the file. 
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If this file is off, Final Gather is forced to use the results from a 
previous Final Gather render. 

Final Gather Freeze

This is the same as Final Gather Rebuild off, except that the Final 
Gather file (once created by reading it from a file or building it for the 
first frame) is not modified (unless the Final Gather File name or Final 
Gather Rays is changed). 

In other words, extra Final Gather points created during rendering are 
appended, and the Final Gather file on disk is not modified. 

This attribute is useful if multiple concurrent renderers share the file. 

Make sure that the Final Gather file matches the scene and viewpoint 
in an animation. 

Image Based Lighting

These are descriptions of the options in the Image Based Lighting section 
in the mental ray tab of the Render Global Settings window.

Create

When you click the Create button a new IBL node is created, replacing 
any currently connected node. (Though multiple IBL environments 
can exist in a scene, only one can be used at a time.) 

For more information, see ”Image-based lighting (sky-like 
illumination)” on page 33 and also ”Render infinitely distant (sky-like) 
illumination and reflection” on page 74.

For descriptions of the attributes in the IBL node, see 

Tip If you are rendering out a still image and are not changing 
the Final Gather settings, turn this attribute off to save 
rendering time.

Tip If you are rendering out a camera animation sequence, you 
may be able to use previous frames’ Final Gather results 
(that is, you can turn this attribute off), depending on how 
the irradiance changes during the animation. Test it out. 

However, if objects in the scene move, this option must be 
on. 
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